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Capitulo 1: Introduccion

Harmony es un software de animacién completo que permite crear todo tipo de proyectos de animacion creativos.
Incluye distintas herramientas y funciones.

En la Guia de introduccién, aprendera las principales funciones que abarcan los conceptos basicos de Toon Boom
Harmony, y que le permitiran ponerse al dia rapidamente. Consulte la documentacion completa de Toon Boom
Harmony disponible en linea en docs.toonboom.com para aprender acerca de todas las herramientas y opciones,
asi como sobre las técnicas avanzadas.

Esta guia se divide en las siguientes partes:

* Acerca de la pantalla de bienvenida

» Creacién de una escena

* Acercade lainterfaz en la pagina 11

» Como dibujaren la pagina 17
» Cdmo pintaren la pagina 19

» Creacion de una animacion tradicional en la pagina 23

» Aplicacion de morphing a dibujos en la pagina 31

* Importacion de imagenes de mapa de bits en la pagina 35

* Creacion de un personaje Cut-out en la pagina 43

» Uso de deformadores en la pagina 51

* Animacion de un personaje Cut-out en la pagina 63

» Creacion de plantillas en la pagina 69

» Configuracion de una escena en la pagina 71

* Creacion de un multiplano en la pagina 85

* Animacion de objetos y de la camara en la pagina 79

* Importacion de sonido y sincronizacion de labios en la pagina 89

» Adicion de efectos a una escena en la pagina 93

» Exportacion de una pelicula en la pagina 97
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Capitulo 2: Acerca de la pantalla de bienvenida

Al iniciar Toon Boom Harmony, aparece la pantalla de bienvenida. Si ya hay una escena abierta, puede mostrar la
pantalla de bienvenida seleccionando Help > Show Welcome Screen (Ayuda > Mostrar pantalla de bienvenida).

La pantalla de bienvenida permite:
1. Crearescenas
2. Seleccionar la resolucion de la escena
3. Abrir escenas recientes de una lista

4. Agregar o eliminar una resolucion de escena personalizada

5. Abra Harmony directamente sin abrir primero la pantalla de bienvenida.

Para mostrar la pantalla de bienvenida mas adelante, vaya al menu superior y seleccione Help > Show
Welcome Screen (Ayuda > Mostrar pantalla de bienvenida).

6. Abrir tutoriales en video de Harmony

7. Abrirla pagina de soporte en linea

8. Abrir escenas desplazandose a las mismas



Harmony 14.0 Advanced - Guia de introduccién (servidor)




Harmony 14.0 Advanced - Guia de introduccién

Capitulo 3: Creacion de una escena

Todas las escenas creadas mediante Harmony Stand Alone son independientes y locales del equipo. Puede crear o
abrir una escena utilizando la pantalla de bienvenida.

Creacién de una escena desde la pantalla de bienvenida

1. Enel campo Name (Nombre), escriba el nombre de la escena.

2. Para seleccionar la ubicacion de la escena, en la seccidn Location (Ubicacion), haga clic en Browse (Exa-
minar).

NOTA: En general, el nombre de la escena no debe superar los 23 caracteres y no puede contener caracteres
especiales, como *&"%!.

3. Enel meni Camera Size (Tamafio de camara), seleccione la resolucién de la escena y haga clic en Create
Scene (Crear escena).

Se crea una nueva escena.
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Capitulo 4: Acerca de la interfaz

Es importante que esté familiarizado con los siguientes elementos de la interfaz de usuario, ya que le serviran de
ayuda para comenzar a usar Toon Boom Harmony. En esta guia puede aprender mas acerca de los puntos que se
describen aqui y de como usarlos en un contexto de produccion.

Al iniciar Toon Boom Harmony por primera vez, el espacio de trabajo predeterminado est4 desactivado. Contiene
todos los elementos principales que necesita usar.

Menuas

- Vista de
ropiedades
Barra de | ge |F;
herr ﬂm'?g‘:'l: herramienta
(Herramientas)
- — Vista de color
Vista de
camara
Barra de
herramientas
Playback | Vista de linea
(Reproducir) de tiempo

Agregar una vista

1. Realice una de las siguientes acciones:

» Seleccione la vista que desee agregar en Windows > vista deseada (Ventanas > vista deseada).

» Enlaesquina superior derecha de una vista, haga clic en el botén Add View (Agregar vista) y
seleccione.

» una vista de lalista. Puede abrir varias instancias de la misma vista, excepto para las vistas de linea de
tiempo, propiedades de herramienta, colory dibujo.

11
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Anclaje de una ventana

1. Arrastre la ventana por su pestafia y realice una de las siguientes acciones:
» Coloque la ventana sobre otras pestafas existentes y agréguela a las demas.

» Coloqgue la ventana por encima, por debajo o junto a una vista existente. Al acercarse al borde de una
vista, aparece un rectangulo negro con fondo azul, que indica dénde se insertara la vista.

12
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La ventana se arrastra por su pestana sobre otras pestanas o encimaldebajo/junto a otras vistas.

Vista de propiedades de la herramienta

La vista de propiedades de la herramienta contextual contiene las opciones y operaciones mas comunes
relacionadas con la herramienta seleccionada actualmente. Al seleccionar una herramienta en la barra de
herramientas Tools (Herramientas), se actualiza la vista de propiedades de la herramienta.

Por ejemplo, si elige la herramienta Select (Seleccionar) & en la barra de herramientas Tools (Herramienta), la

vista de propiedades de la herramienta muestra las opciones y operaciones relacionadas con la herramienta Select
(Seleccionar), como Snap to Contour (Ajustar a contorno), Snap and Align (Ajustar y alinear), Flip Horizontal (Voltear
en horizontal) y Flatten (Acoplar).

Interfaz de navegacion

Toon Boom Harmony permite acercar, alejar, rotar, paneary restablecer vistas para navegar facilmente por la
interfaz.

Comando Accion Métodos de acceso

13
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Zoom In (Acercar)

Acerca la vista.

View > Zoom In (Ver>
Acercar)

Pulse 2 o gire la rueda del
ratén hacia arriba.

En la vista de linea de
tiempo, gire la rueda del ratén
hacia arriba.

Zoom Out (Alejar)

Aleja la vista.

View >Zoom Out (Ver >
Alejar)

Pulse 1 o gire la rueda del
ratén hacia abajo.

En lavista de linea de
tiempo, gire la rueda del ratén
hacia abajo.

Zoom In or Out (Acercar o alejar)

Acerca o aleja la vista.

Gire la rueda central del raton
hacia arriba o hacia abajo.

Pan (Panear)

Se mueve en paralelo a la vista.

Mantenga pulsada la barra
espaciadora y arrastre en la
direccién en la que desea
panear la vista.

posicion predeterminada.

Recenter view (Volver a centrar vista) | Vuelve a centrar la vista sobre el puntero. | Pulse N
View > Reset Pan (Ver>
R I | pan i
Reset Pan (Restablecer paneo) establece el paneo de vista a su Restablecer paneo)

Pulse Mayus + N

Reset View (Restablecer vista)

Restablece la vista a su posicion
predeterminada.

View > Reset View (Ver >
Restablecer vista)

Pulse Mayus + M

Reset Rotation (Restablecer rotacion)

Restablece la rotacion de vista a su
posicion predeterminada.

View > Reset Rotation (Ver
> Restablecer rotacion)

Pulse Mayus + X

Reset Zoom (Restablecer zoom)

Restablece el zoom de vista a su
posicion predeterminada.

View > Reset Zoom (Ver >
Restablecer zoom)

Toggle Full Screen (Alternar pantalla
completa)

Amplia la vista seleccionada a la pantalla
completa, lo que se consigue en tres
fases.

En primer lugar, la vista seleccionada se
amplia a la anchura o altura maximas,
pero conserva las vistas de herramienta,
como la vista de colory de propiedades
de la herramienta.

En segundo lugar, la vista se amplia a

View > Toggle Full Screen
(Ver > Alternar pantalla
completa)

Pulse Ctrl + F
(Windows/Linux) 0 3§ +F
(Mac OS X)

14
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pantalla completa.

Por ultimo, la vista regresa a su tamafio
original.

Rotate 30 CW (Rotar 30 derecha) Rota la vista de camara 30 grados a la View > Rotate View CW
derecha, como una mesa de animacién. | (Ver> Rotar 30 derecha)
Rota la vista de camara 30 grados a la View > Rotate View CCW

Rotate 30 CCW (Rotar 30 izquierda)

izquierda, como una mesa de animacion.

(Ver > Rotar 30 izquierda)

Toggle Quick Close-up (Alternar primer
plano rapido)

Use la herramienta Magnifier (Lupa) para
centrar la imagen rapidamente en la
posicion del raton y acercarla un valor
predefinido, como 4X. A continuacion,
puede alejarla de nuevo. Mantenga
pulsada la tecla Mayus y pulse Z para
acercary para volver a alejar. Sustituya
el restablecimiento de zoom pulsando
Mayus +.

El &rea en el que acerca o aleja laimagen
depende de la ubicacién del puntero en la
vista de camara. Si alejalaimageny
después mueve el puntero a una
ubicacion distinta al alejar el raton, la
imagen se centrara en esa ubicacion.

NOTA: Si utiliza una tableta o un trackpad que admita funcién tactil, también puede utilizar los gestos de dos dedos
estandar para zoom, rotacion y paneo en las vistas de camara y dibujo.

15
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Capitulo 5: Coémo dibujar

Una vez iniciado Toon Boom Harmony, puede comenzar a dibujar inmediatamente utilizando la capa de dibujo
predeterminada.

Coémo dibujar

1. Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Brush (Pincel) g o pulse Alt +
B.

2. Enlavistade linea de tiempo o de carta de exposicion, haga clic en la primera celda de la capa de dibujo.

4. Para seleccionar un color distinto, en la vista de color, seleccione una muestra de color distinta. Haga doble
clic en la muestra de color para abrir la ventana Colour Picker (Selector de color) y cambiar el color. Recuerde
que todo lo que ya esté pintado con dicho color se actualizara al nuevo.

Colour =%

17
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Capitulo 6: Como pintar

Toon Boom Harmony incluye algunas funciones de coloreado muy utiles a la hora de pintar. Para pintar los dibujos,
utilizara distintas muestras de color, a diferencia de otros programas de pintado en los que modifica la muestra
principal cada vez que desea pintar con un color diferente.

En la vista de color, seleccione una muestra de color distinta para cada color que desee pintar en el dibujo. Puede
agregar todas las muestras de color que desee. También puede cambiar el nombre a las existentes y modificarlas.

HO0AR0OgNNG

Cuando modifique el color de una muestra de color existente, actualiza automaticamente todas las zonas pintadas
con esta muestra en todo el proyecto. La muestra de color tiene un numero de ID exclusivo que la asocia con las
zonas pintadas. De este modo, puede cambiar el aspecto del personaje en cualquier momento sin necesidad de
volver a pintarlo.

En animacion se utilizan colores especificos para pintar cada personaje especifico. Con el fin de mantener una
coherencia absoluta, se crea una paleta de colores para cada personaje, prop y efecto de la produccion. A esto sele
denomina paleta maestra.

19



Capitulo 6: Coémo pintar

Las paletas maestras contienen una muestra de color para cada zona que se debe colorear con un valor de color
RGBA preciso.

El uso de una paleta de colores maestra tiene muchas ventajas, entre otras:
» Cada personaje conserva permanentemente sus colores especificos.
» No puede usar por error un color que no esté en la paleta maestra.
» Estandarizacion y coherencia del color durante la produccion
» Varios artistas pueden usar la misma paleta de colores y generar los mismos resultados.

Toon Boom Harmony utiliza paletas para mantener todos los colores necesarios para pintar los elementos,
permitiendo un control y coherencia totales del proceso de pintado.

Una paleta se crea asignando un conjunto de colores a cada personaje, prop o efecto. Creara una nueva paleta y
agregara un nuevo color, conocido como muestra de color, para cada zona del personaje, como piel, pelo, lengua,
camiseta, pantalones, etc.

Como pintar dibujos

1. Enlavista de linea de tiempo o de carta de exposicion, seleccione el dibujo que desea pintar.

2. Enla barra de herramientas Tools (Herramientas), seleccione la herramienta Paint (Pintar) # o pulse Alt
+1.

3. Enlavistade color, seleccione una paleta.

4. Seleccione un color de la paleta.

» Sitrabaja con capas de vectores, haga doble clic en la muestra de color para abrir la ventana Colour
Picker (Selector de color) y modificar el color.

» Sitrabaja con capas de mapa de bits, utilice los controles RGB/HSV para seleccionar un color.

20
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Scene Palettes Scene Palettes
)

IA W]

Colorear vista al trabajar con capas de vectores Colorear vista al trabajar con capas de mapa de bits

NOTA: La paleta de colores solo aparece en la vista de color al seleccionar un elemento de dibujo.

5. Enlavista de dibujo o de camara, comience a pintar el dibujo con los colores.

Cierre de huecos

21



Capitulo 6: Coémo pintar

Al pintar, tenga en cuenta que algunas de las areas de su dibujo no estan cerradas. Para cerrar la zona, puede
dibujar la linea que falta con las herramientas Brush (Pincel) o Pencil (Lapiz ), o bien cerrar el hueco con una linea
invisible. Para ello, se utiliza la herramienta Close Gap (Cerrar hueco).

La herramienta Close Gap (Cerrar hueco) permite cerrar huecos pequefios en un dibujo. La herramienta Paint
(Pintar) solo pinta areas cerradas. La herramienta Close Gap (Cerrar hueco) permite crear pequenas pinceladas
invisibles entre los dos puntos mas cercanos para cerrar la zona de color. No es necesario que realice el trazo
directamente sobre el hueco. Puede dibujarlo con varios milimetros de separacién y la herramienta Close Gap
(Cerrar hueco) elegira automaticamente los dos puntos mas cercanos y cerrara el hueco.

Uso de la herramienta Close Gap (Cerrar hueco)

1. Realice una de las siguientes acciones:

» Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Close Gap (Cerrar hueco)
Ve

» En el menu superior, seleccione Drawing > Drawing Tools > Close Gap (Dibujo > Herramientas de
dibujo > Cerrar hueco).

» PulseAlt+ C.

2. Enlavista de propiedades de la herramienta, pulse el boton Auto-Flatten (Acoplamiento automatico) f
si desea que la pincelada que ha dibujado quede acoplada en el dibujo en lugar de permanecer sobre el
mismo.

3. Puede mostrar lineas invisibles seleccionando View > Show > Show Strokes (Ver > Mostrar > Mostrar
pinceladas) o pulse K. Si no muestra las pinceladas, aparecera un cuadro de mensaje.

5 Message RS

Seleccione la opcion Don’t Show This Message Again (No volver a mostrar este mensaje) para impedir
que vuelva a aparecer este cuadro de mensaje.

4. Enlavista de cdmara o de dibujo, trace una linea invisible cerca del hueco que se va a cerrar.

El hueco se cierra automaticamente.
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Capitulo 7: Creacion de una animacion tradicional

El primer paso para completar una animacion sin papel tradicional es la creacion de un boceto, que es el esqueleto
de la animacion. Habitualmente, comenzaria con la accion principal. Por ejemplo, para animar un ciclo de andar,
comenzara por el movimiento del torso y de las piernas. La cabeza, brazos y ropa se agregaran mas adelante
durante la animacién secundaria.

Para conseguir una animacion satisfactoria, complete la accion principal antes de agregar todos los detalles. Si
comienza a animar todos los detalles inmediatamente, perdera mucho tiempo en caso de tener que realizar
correcciones. Con frecuencia, la animacioén parecera demasiado rigida.

Como animar

1. Pulse Ctrl + U (Windows/Linux) o 3£ + U (Mac OS X) para abrir el cuadro de dialogo Preferences (Pre-
ferencias).

2. Seleccione la pestafia Exposure Sheet (Carta de exposicion).

3. Seleccione la opcion Use Current Frame as Drawing Name (Usar fotograma actual como nombre de
dibujo). Cuando esta preferencia esté activada, los dibujos tendran el mismo nombre que el fotograma en el
que se hayan creado (nimero de fotograma).

4. Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Brush (Pincel) g o pulse Alt +
B.

5. Enlavista de color, seleccione un color para el pincel. Es una buena idea elegir un color claro para el boceto
de animacion. Servira de ayuda en la siguiente tarea, el proceso de clean up.
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Capitulo 7: Creacion de una animacion tradicional

6. Enlavista de linea de tiempo o de carta de exposicién, seleccione la celda en la que desea que aparezca
el primer dibujo.

7. Enlavista de camara o de dibujo, dibuje el primer dibujo clave.

8. Con la primera celda aun seleccionada, realice una de las siguientes acciones para marcar el dibujo como
dibujo clave. Esto le ayudara a mantener el orden.

» Enla barra de herramientas Mark Drawing (Marcar dibujo), haga clic en el botén Mark Selected

Drawings as Key (Marcar dibujo como dibujo clave) @

» Enlavista de carta de exposicién, seleccione Drawings > Mark Drawing As > Key Drawing
(Dibujos > Marcar dibujo como > Dibujo clave).

» Enlavista de linea de tiempo, seleccione Drawings > Mark Drawing As > Key Drawing (Dibujos >
Marcar dibujo como > Dibujo clave).

9. Enlabarra de herramientas Tools (Herramientas), haga clic en el botén Onion Skin (Papel cebolla) f; La

funcion Onion Skin (Papel cebolla) muestra los dibujos anterior y siguiente como referencias visuales | para
ayudarle a dibujar su nueva pose.
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10. Enlavista de linea de tiempo, haga clic y arrastre los marcadores azules de papel cebolla para ampliar el
numero de dibujos visibles anteriores y siguientes.

11. Enla barra de herramientas Camera View (Vista de camara) o Drawing View (Vista de dibujo), pulse Reduce
One Next/Previous Drawing (Reducir un dibujo anterior/siguiente) o Add One Next/Previous Drawing (Agre-
gar un dibujo siguiente/anterior) de papel cebolla para reducir o aumentar el numero de dibujos visibles ante-
riores y posteriores. Los iconos rojos ... .. corresponden a los dibujos anteriores y los iconos verdes =
== 3 |0s posteriores. T

(===

12. Enlavista de linea de tiempo o de carta de exposicion, seleccione la celda en la que desea que aparezca el
préximo dibujo clave.

13. Enlavista de camara o de dibujo, dibuje el segundo dibujo clave.

15. Enlavista de linea de tiempo o de carta de exposicion, seleccione una celda entre los dos dibujos clave.
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Capitulo 7: Creacion de una animacion tradicional

16.  Enlavista de linea de tiempo, haga clic en Create Empty Drawing (Crear dibujo vacio) %] para crear un
dibujo vacio o pulse Alt + Mayus + R.

» Enlavista de carta de exposicion, haga clic con el boton derecho y seleccione Drawings > Create
Empty Drawing (Dibujos > Crear dibujo vacio) o pulse Alt + Mayus + R.

NOTA: En lugar de crear un dibujo vacio, puede comenzar a dibujar directamente.

17. Enlavista de camara o de dibujo, dibuje la nueva pose.

18.  Sies necesario, en la vista de carta de exposicién o de linea de tiempo, identifique el nuevo dibujo como
un nuevo dibujo clave, de descomposicion o intercalado mediante la barra de herramientas Mark Drawing
(Marcar dibujo).
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19.

20.

b

T

Am N

Utilice las barras de herramientas Flip (Hojear) y Easy Flipping (Flipping sencillo) para revisar la animacion.

En la vista de linea de tiempo o de carta de exposicion, seleccione una nueva celda y repita los pasos ante-
riores para cada nuevo dibujo.

21. Enlavista de linea de tiempo, utilice los botones Enable/Disable All (Activar/desactivar todo) (,, y Solo @
para desactivar todas las capas que no desee ver durante la reproduccion.

22. Parareproducir en bucle, mueva el cabezal de reproduccion rojo al fotograma de inicio que desee y haga clic
en el botdn Start (Iniciar) de la barra de herramientas Timeline (Linea de tiempo). Mueva el cabezal al Ultimo
fotograma de la reproduccion y haga clic en el botén Stop (Detener).

23. Enla barra de herramientas Playback (Reproducir), haga clic en el botén Loop (Bucle) ) parainiciar la repro-
duccion.

24. Enlabarra de herramientas Playback (Reproducir), haga clic en el botén Play (Reproducir) g para iniciar la
animacion.

Limpieza
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Capitulo 7: Creacion de una animacion tradicional

Una vez que se haya completado el boceto de animacion, es el momento de limpiarlo y tintarlo. A este paso
también se le denomina trazado. Consiste en trazar lineas solidas y limpias sobre el boceto de animacion para
cerrar las zonas abiertas. Es el paso final de la animacion sin papel antes del paso de ink and paint.

Debera agregar una nueva capa de dibujo para el dibujo limpio. Equivale a agregar una hoja de papel y trazar el
boceto utilizando el disco de animacion. Este método permite mantener los bocetos y los dibujos limpios
intactos. Solo debe desactivar la capa de boceto para impedir que aparezca en la escena.

Si tiene pensado trazar la animacion en la vista de dibujo, puede activar la mesa de luz para mostrar todas las
capas en el proyecto.

Trazado de la animacién en una nueva capa

1. Enlavista de linea de tiempo, haga clic en el botén Add Drawing Layer (Agregar capa de dibujo) 42. o
pulse Ctrl + R (Windows/Linux) o 3£ + R (Mac OS X).

Se abre la capa Add Drawing Layer (Agregar capa de dibujo).

®
o

Add and Close Close

2. Enelcampo Name (Nombre), escriba el nombre de la nueva capa.

3. Establezca las opciones Line Art (Capa de lineas) y Colour Art (Capa de color) en Vector para obtener una
capa de vectores o en Bitmap (Mapa de bits) para tener una capa de mapa de bits.

4. Realice una de las siguientes acciones:
» Haga clic en Add (Agregar) para agregar una primera capa y mantener la ventana abierta para agregar
mas capas.
» Haga clic en Add and Close (Agregary cerrar) para agregar una nueva capa y cerrar la ventana.
Se agrega a la vista de linea de tiempo una nueva capa de dibujo.

5. Enlavista de linea de tiempo, haga clic en el icono Lock (Bloguear) de la capa que contiene el boceto
de animacion para impedir que dicha capa se pueda seleccionar en la vista Camera (Camara).

6. Enlavistade linea de tiempo o de carta de exposicion, seleccione la celda de la nueva capa que corres-
ponda al primer dibujo clave del boceto de animacién.

7. Enlabarra de herramientas Tools (Herramientas), seleccione una herramienta de dibujo, como la herra-
mienta Pencil (Lapiz)
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& -

8. Enlavistade color, seleccione un color para trazar la animacioén. Seleccione un color oscuro intenso, como

el negro, para asegurarse de conseguir un contraste adecuado con el color claro del boceto de animacion.

9. Enlavista de camara o de dibujo, comience a trazar el primer dibujo clave.

10.

11.

12.

13.

14.

Si tiene otras capas en medio, puede desactivarlas temporalmente en la vista de linea de tiempo, de modo
gue unicamente se muestren el boceto de animacién y la capa de clean up en la vista de camara.

En la barra de herramientas Tools (Herramientas), haga clic en el botén Enable Onion Skin (Activar papel
cebolla) £..

Si no utiliza la opcion Onion Skinning by Drawing (Usar papel cebolla mediante dibujo), extienda el rango de
papel cebolla en la vista de linea de tiempo; en caso contrario, utilice los botones Add One Previous Drawing
(Agregar un dibujo anterior) y Add One Next Drawing (Agregar un dibujo siguiente) de papel cebolla en la barra
de herramientas de dibujo o de vista de camara para agregar dibujos a la vista de papel cebolla.

o=

En la vista de linea de tiempo o de carta de exposicién, seleccione la siguiente celda que corresponde a un
boceto de dibujo.

En la vista de camara, trace el siguiente dibujo.
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15. Repitalos pasos anteriores para cada dibujo.
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Capitulo 8: Aplicacion de morphing a dibujos

Cuando se trata de morphing, debera practicar y adquirir soltura con esta funcion. Una vez que esté familiarizado
con las reglas basicas, puede comenzar a crear secuencias de morphing. Para comenzar, utilice elementos
sencillos. Cuando tenga la suficiente confianza con el proceso de morphing, puede comenzar a usar técnicas de
morphing complejas y avanzadas, como rotaciones de cabeza o de personajes completos.

Puede que desee eliminar una secuencia de morphing completa para rehacer una secuencia desde el principio.

Creacion de un elemento de morphing basico

1. Enla barra de herramientas Timeline (Linea de tiempo), haga clic en el boton Add Drawing Layer (Agregar
capa de dibujo) 48 para agregar una nueva capa al proyecto.

2. Cambie el nombre de la nueva capa (por ejemplo, Morphing).

3. Enlavista de linea de tiempo o de carta de exposicion, seleccione la primera celda de la capa.

4+ — % % Parameters
]

+

4. Realice una de las siguientes acciones:

» Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Rectangle (Rectangulo) [

» PulseAlt + 7.
5. Enlavista de camara o de dibujo, dibuje un rectangulo.

6. Realice una de las siguientes acciones o ambas:

» Mantenga pulsada la tecla Mayus para dibujar un cuadrado.
» Mantenga pulsada la tecla Alt para dibujar un rectangulo a partir de su centro.

7. Pinte el rectdngulo con la herramienta Paint (Pintar).
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8.

9.

10.

11.

12.

En la vista de carta de exposicion o de linea de tiempo, vaya a la celda en la que desea que termine la
secuencia de morphing.

Realice una de las siguientes acciones:

» Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Ellipse (Elipse) (5 .
» PulseAlt+=.

Dibuje y pinte la elipse utilizando el mismo color de contorno que en el rectangulo.

En la vista de carta de exposicion o de linea de tiempo, seleccione el primer fotograma y todos los foto-
gramas hasta el ultimo incluido, que es el dibujo de rectangulo.

\

Realice una de las siguientes acciones:

» En el menu superior, seleccione Animation > Morphing > Create Morphing (Animacién > Morphing
> Crear morphing).

» Enlavista de carta de exposicion o de linea de tiempo, haga clic con el botén derecho y seleccione
Morphing > Create Morphing (Morphing > Crear Morphing).

» Pulse Alt + M.
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Aparecen flechas entre los dos dibujos clave para mostrar que se han creado intercalados generados por
ordenador.

NOTA: Utilice la barra de herramientas Playback (Reproducir) para reproducir la secuencia de morphing. Para

desplazarse por los intercalados, alterne entre coma (, ) y punto (. ). Pulse F4 para alternar entre los dos dibujos
clave.

Eliminacion de una secuencia de morphing completa

1. Enlavista de carta de exposicién o de linea de tiempo, seleccione una celda en la secuencia de morphing.
2. Realice una de las siguientes acciones:

» En el menu superior, seleccione Animation > Morphing > Delete Morphing (Animacién > Morphing >
Eliminar morphing).

» Enlavista de carta de exposicion o de linea de tiempo, seleccione Morphing > Delete Morphing
(Morphing > Eliminar Morphing).

» Haga clic con el boton derecho en la secuencia y seleccione Morphing > Delete Morphing (Morphing >
Eliminar Morphing).

Se quita toda la secuencia entre los dos fotogramas clave.
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Capitulo 9: Importacion de imagenes de mapa de bits

Una imagen de mapa de bits es una imagen compuesta por pixeles que dependen tanto del tamafio como de la
resolucion. En Harmony, puede importar imagenes de mapa de bits y vectorizarlas para poder editarlas. A
continuacion, puede utilizar distintas herramientas de dibujo para editar laimagen. También puede conservar la
imagen de mapa de bits tal cual.

También puede importar imagenes en capas de mapa de bits o vectores en funcion del proyecto.

NOTA: Un modo rapido de importar una imagen de mapa de bits es arrastrar y colocar la imagen de mapa de bits
directamente desde la libreria en la escena (camara). Sin embargo, no tendra acceso a todas las opciones de
importacion.

Apertura del cuadro de didlogo Import Images (Importar imagenes)

1. Realice una de las siguientes acciones:

» En el menu superior, seleccione File > Import > Images (Archivo > Importar > Imagenes).
» Enlabarra de herramientas File (Archivo), haga clic en el boton Import Images (Importarimagenes) B

» Enlavista de carta de exposicion, haga clic con el botdn derecho en cualquier parte del area de
fotogramas y seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de dialogo Import Images (Importarimagenes).

Alignment

Rules

Transpai

Alpha: emultiplied w

Cancel

Importacion de una imagen de mapa de bits en su formato original

1. Enlaseccion Files (Archivos) del cuadro de dialogo Import Images (Importar imagenes), haga clic en
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Browse (Examinar) para buscar y seleccionar una o mas imagenes en el ordenador.

2. Decida silaimagen de mapa de bits se incluira en una nueva capa o en una capa existente. Para agregar
la imagen de mapa de bits a una nueva capa, vaya al paso 3. Para agregar laimagen de mapa de bits a
una capa existente, vaya al paso 4.

3. Agregue laimagen de mapa de bits a una nueva capa seleccionando la opcion Create Layer(s) (Crear
capas) y una de las siguientes opciones. A continuacién, continte con el paso 5:

» Create Single Layer Named (Crear una sola capa con nombre): Crea una capa a la que puede
asignar un nombre.

» Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo): Crea una
capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, los nombres de archivo a-1.tga,
a-2.tgay b-1.tga crearan capas llamadas "a" y "b," donde "a" tiene dos dibujos y "b" uno. Al crear una
sola capa a partir de estos tres nombres de archivos, los tres dibujos se insertaran en la capa creada.

4. Seleccione la opcion Add to Existing Layer (Agregar a capa existente) para colocar laimagen de mapa
de bits en una capa que seleccione de la lista. Si solo hay disponibles capas de vectores en la escena, no
se mostraran en la lista. Puede elegir encapsular el mapa de bits en un simbolo seleccionando la opcién
Create Symbols for Imported Items (Crear simbolos para elementos importados).

5. Enlaseccion Import Options (Opciones de importacion), seleccione la opcion Keep As Original Bitmap
(Mantener como mapa de bits original). En la seccion Alignment (Alineacion), decida el tamafio y la posi-
cioén de la imagen dentro del encuadre de cdmara. Segun la configuracion de la escena (la alturay la
anchura en pixeles que elija para el proyecto), una imagen importada se puede escalar hasta el punto en el
que sean visibles todos los pixeles individuales. La seccion Alignment (Alineacion) cuenta con tres opcio-

nes:
Parametro Descripcion
Aumenta o reduce (pero no distorsiona) la altura de la imagen
para que se ajuste a la altura total de la cuadricula de la escena.
Resolucién de
camara
Fit (Ajustar)

Fotograma de
escena (cuadricula)

Imagen vertical con
regla de alineacién de
ajuste

Si la orientacion de la imagen es horizontal, aumenta o reduce
(pero no distorsiona) la anchura de la imagen para que se ajuste
ala de la cuadricula de la escena.
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Resclucidn de
camara

Fotegrama de
escena (cuadricula)
Imagen horizantal con
ragla de alineacién de
ajuste

Tenga en cuenta que la regla de alineacion Fit (Ajustar) es igual
gue la regla Center Fit (Ajuste centro) de las propiedades de la
capa.

Es lo opuesto al parametro Fit (Ajustar). Si la orientacion de la
imagen es vertical, su anchura se ajustara a la cuadricula de la
escena. Como resultado, parte de la altura de la imagen
rebasara la altura del fotograma. Esto puede ser Util si desea que
el fondo se mueva hacia arriba y hacia abajo, o de izquierda a
derecha para que parezca como si la camara estuviese
paneando o que realmente se realice un paneo de camara.

Imagen vertical con
regla de alineacién de
paneo

Pan (Panear)

Resolucidn de
camara

Folograma de
escena (cuadricula)

Lo opuesto se aplicaria a una imagen horizontal. Su altura se
ajustara a la cuadricula de la escena, por lo que es posible que la
imagen rebase los limites de la cuadricula de la escena.
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Fotograma de Resolucién
escena (cuadricula)  de cdmara

Imagen horizontal con regla de alineacién de paneo

Tenga en cuenta que la regla de alineacioén Pan (Panear) es igual
que la regla Center First Page (Centrar primera pagina) de las
propiedades de la capa.

Escala laimagen proporcionalmente a la resolucion de la
escena. El sistema toma la resolucion de la imagen de mapa de
bits, por ejemplo, 4000 x 2000 y, a continuacion, la compara con
la resolucion de la escena, por ejemplo 1920 x 1080, y ajusta el
factor de escala proporcionalmente. Por lo tanto, en este
ejemplo el mapa de bits apareceria al 208 % (4000/1920). Si
importa un mapa de bits de 960 x 540, se mostrar4 al 50 %
(960/1920) del tamaiio de la resolucidon del proyecto.

Project Resolution (Reso-
lucion del proyecto)

Tenga en cuenta que la regla de alineacién Project Resolution
(Resolucion del proyecto) es igual que la regla As Is (Tal cual) de
las propiedades de la capa.

6. Enlaseccion Transparency (Transparencia), seleccione una de las siguientes opciones en el menu Alpha

(Alfa):
Parametro Descripcién
Premultiplied with White Los pixeles individuales del borde de una imagen se mezclan

(Premultiplicado con blanco) | con blanco.

Premultiplied with Black Los pixeles semitransparentes de la imagen original se mezclan
(Premultiplicado con negro) con hegro.

Los pixeles del borde de una imagen se mezclan con negro,

ight (R .
Straight (Recto) blancoy grises.
Premultiplica el valor de color con el valor de alfa. Cuando el
Cl Col Aloha (Fii color se fija al alfa, el valor de color no puede ser mayor que el
amp Colourto Alpha (Fijar valor de alfa. Calcula el valor de color real mas rapido. Cuando
color a alfa)

los valores de RGB se multiplican con el valor de alfa, por
ejemplo, si tiene un pixel con el valor R=247, G=188, B=29y el
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alfa es del 50 % o la imagen tiene una transparencia del 50 %,
los valores de RGB reales que se generan serian la mitad de las
cantidades indicadas.

7. Haga clic en OK (Aceptar).

Importacién de una imagen de mapa de bits como un dibujo de mapa de bits de Toon Boom

1. Enlaseccion Files (Archivos) del cuadro de dialogo Import Images (Importar imagenes), haga clic en Bro-
wse (Examinar) para buscary seleccionar una o mas imagenes en el ordenador.

2. Enlaseccién Import Options (Opciones de importacion), seleccione la opcion Import asToon Boom Bitmap
Drawing (Importar como dibujo de mapa de bits de Toon Boom).

3. Decida silaimagen de mapa de bits se incluira en una nueva capa o en una capa existente. Para agregar la
imagen de mapa de bits a una nueva capa, vaya al paso 4. Para agregar la imagen de mapa de bits a una
capa existente, vaya al paso 5.

4. Enlaseccion Layer (Capa), seleccione la opcion Create Layer (Crear capa) y una de las siguientes opcio-
nes para agregar laimagen de mapa de bits a una nueva capa:

» Create Single Layer Named (Crear una sola capa con nombre): crea una capa a la que puede asignar
un hombre.

» Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo): crea una capa
basada en cada prefijo de nhombre de archivo unico. Por ejemplo, los nombres de archivo a-1.tga, a-2.tga
y b-1.tga crearan capas llamadas "a" y "b," donde "a" tiene dos dibujos y "b" uno. Al crear una sola capa a
partir de estos tres nombres de archivos, los tres dibujos se insertaran en la capa creada.

5. Seleccione la opcion Add to Existing Layer (Agregar a capa existente) para colocar la imagen de mapa de
bits en una capa que seleccione de la lista. Si solo hay disponibles capas de vectores 4™ en la escena, no
se mostraran en la lista. Puede elegir encapsular el mapa de bits en un simbolo seleccionando la opcién
Create Symbols for Imported Items (Crear simbolos para elementos importados).

6. Enlaseccion Alignment (Alineacion), decida el tamafo y la posicion de la imagen dentro del encuadre de
camara. Segun la configuracion de la escena (la altura y la anchura en pixeles que elija para el proyecto), una
imagen importada se puede escalar hasta el punto en el que sean visibles todos los pixeles individuales.

Alignment

NOTA: Asegurese de estar en el modo Render de la vista de cdmara al juzgar una imagen mejorada;
de lo contrario, puede aparecer difuminada. También puede ajustar la calidad de una imagen de
mapa de bits mostrada en el modo OpenGL mediante View > Bitmap File Quality (Vista > Calidad del
archivo de mapa de bits). Debe seleccionar la imagen de mapa de bits utilizando la herramienta
Transform (Transformar).

Se encuentran disponibles las tres opciones de reglas de alineacion siguientes:
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Parametro Descripcién

Aumenta o reduce (sin distorsion) la altura de la imagen para que se
ajuste a la altura total del fotograma de la escena (cuadricula de
alineacion).

Vertical Fit (Ajuste ver-
tical)

Resolucion de
camara

Imagen con regla de
alineacién de ajuste Faotograma de
vartical escena (cuadricula)

Aumenta o reduce (sin distorsion) la anchura de la imagen para que se
ajuste a la anchura total del fotograma de la escena (cuadricula de
alineacion).

Horizontal Fit (Ajuste hori-

zontal)
Resolucidn de
camara
Imagen con regla de Fotograma de
alineacion de ajuste escena (cuadricula)
harizental
Escala laimagen proporcionalmente a la resolucion de la escena. El
sistema toma la resolucion de la imagen de mapa de bits, por ejemplo,
4000 x 2000 y a continuacion, la compara con la resolucién de la
Actual Size (Tamafo escena, por ejemplo 1920 x 1080, y ajusta el factor de escala
real) proporcionalmente. Por lo tanto, en este ejemplo el mapa de bits

apareceria al 208 % (4000/1920). Si importa un mapa de bits de 960 x
540, se mostrara al 50 % (960/1920) del tamafio de la resolucién del
proyecto.

7. Enlaseccion Transparency (Transparencia) decida como desea que se suavice laimagen de mapa de
bits, en concreto, la forma en que los pixeles a lo largo del borde se mezclan en los canales RGBA (rojo,
verde, azul, alfa (transparente)). La imagen de mapa de bits existira en la capa de mapa de bits del ele-
mento de dibujo que se acaba de crear.
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Parametro Descripcién

Premultiplied with White Los pixeles individuales del borde de una imagen se mezclan con
(Premultiplicado con blanco) | blanco.

Premultiplied with Black Los pixeles individuales del borde de una imagen se mezclan con
(Premultiplicado con negro) negro.

Los pixeles del borde de una imagen se mezclan con negro, blanco

Straight (Recto) y grises

8. Haga clic en OK (Aceptar).

Importacién de una imagen de mapa de bits y conversién a dibujo de vector de Toon Boom

1. Enlaseccion Files (Archivos) del cuadro de didlogo Import Images (Importar imagenes), haga clic en Bro-
wse (Examinar) para seleccionar una o mas imagenes en el ordenador.

2. Enlaseccion Import Options (Opciones de importacion), seleccione la opcion Convert to Toon Boom Vec-
tor Drawing (Convertir a dibujo de vector de Toon Boom).

3. Decida silaimagen de mapa de bits se incluira en una nueva capa o en una capa existente. Para agregar la
imagen de mapa de bits a una nueva capa, vaya al paso 4. Para agregar laimagen de mapa de bits a una
capa existente, vaya al paso 5.

4. Enlaseccion Layer (Capa), seleccione la opcion Create Layer (Crear capa) y una de las siguientes opcio-
nes para agregar laimagen de mapa de bits a una nueva capa:

» Create Single Layer Named (Crear una sola capa con nombre): Crea una capa a la que puede asignar
un nombre.

» Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo): Crea una capa
basada en cada prefijo de nombre de archivo unico. Por ejemplo, los nhombres de archivo a-1.tga, a-2.tga
y b-1.tga crearan capas llamadas "a" y "b," donde "a" tiene dos dibujos y "b" uno. Al crear una sola capa a
partir de estos tres nombres de archivos, los tres dibujos se insertaran en la capa creada.

5. Seleccione la opcion Add to Existing Layer (Agregar a capa existente) para colocar laimagen de mapa de
bits en una capa que seleccione de la lista. Si solo hay disponibles capas de vectores 4™ en la escena, no
se mostraran en la lista. Puede elegir encapsular el mapa de bits en un simbolo seleccionando la opcién
Create Symbols for Imported Items (Crear simbolos para elementos importados).

6. Enlaseccion Vectorization (Vectorizacion), decida si desea importar laimagen en blanco y negro o en gri-
ses.
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Parametro Descripcién
Black and White (Blancoy Vectoriza los dibujos como una linea negra solida; crea un dibujo
negro) 100 % basado en vectores.
Vectoriza la imagen como una mezcla de contorno vectorial y
Grey (Gris) relleno de mapa de bits en escala de grises. Las lineas con-
y servan la textura de la digitalizacion y el blanco del papel pasa a
ser transparente.
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Capitulo 10: Creacién de un personaje Cut-out

Se pueden emplear muchas técnicas para descomponer una marioneta. En esta seccién, aprendera uno de los
métodos mas comunes y sencillos. Para la primera descomposicion de personaje, siga estas instrucciones para
hacerse una idea de como funciona Harmony. Una vez que conozca las funciones y comandos basicos de
Harmony, podra crear sus propias técnicas para cumplir las necesidades de su produccion.

Dibujo de las piezas

La técnica de descomposicion principal que se muestra es el trazado del modelo.

Descomposicion de un personaje

1. Enlavista de linea de tiempo, afiada una nueva capa de dibujo para cada parte del cuerpo que desee separar.
Puede pulsar Ctrl + R (Windows/Linux) o &£ + R (Mac OS X).

+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1

2. Enlavista de linea de tiempo, seleccione la primera celda de la capa en la que desea dibujar la parte.
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3. Enlabarra de herramientas Tools (Herramientas), seleccione una herramienta de dibujo.

4. Enlavista de color, seleccione una muestra de color. Si todavia no ha creado ninguna paleta para el per-
sonaje, consulte Como pintaren la pagina 19.

5. Enlavista de camara o de dibujo, dibuje la nueva parte con el menor nimero de puntos posibles, de modo
que las piezas se puedan manipular, modificar o volver a dibujar facilmente. Este proceso puede ser mas
facil con la herramienta Polyline (Polilinea) g .

Si trabaja en la vista de dibujo, haga clic en el boton Light Table (Mesa de luz) de la barra de
herramientas Drawing View (Vista de dibujo) para mostrar las demas capas y colores lavados. También
puede pulsar Mayus + L.

6. Puede utilizar la herramienta Stroke (Linea vectorial transparente) de la barra de herramientas Tools (Herra-
mientas) para crear una fina linea invisible si desea cerrar una forma sin dibujar la pincelada real.

» Seleccione View > Show > Show Strokes (Ver > Mostrar > Mostrar lineas vectoriales transparentes)
o pulse K para mostrar las lineas invisibles.

7. Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Paint (Pintar) # o pulse
Paint Unpainted (Pintar despintado) 8 para colorear el dibujo.

8. Enlavistade color, seleccione el color correspondiente.

9. Enlavista de camara o de dibujo, pinte el dibujo.

44



Harmony 14.0 Advanced - Guia de introduccién

10. Enla barra de herramientas Tools (Herramientas), seleccione la herramienta Select (Seleccionar) w . Selec-
cione el dibujo y acople las lineas haciendo clic en el boton Flatten (Acoplar) == de la vista de propiedades
de la herramienta.

11. Silas lineas estan compuestas por varias pinceladas de lapiz, puede que desee combinarlas en una Unica
linea de lapiz fluida. Mediante la herramienta Select (Seleccionar), seleccione las lineas de lapiz que se
deben combinary, en la vista de propiedades de la herramienta, haga clic en la herramienta Merge Pencil
Lines (Combinar lineas de lapiz) X -

12. Repita todo el proceso hasta terminar la descomposicion.
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Adicién de pegs

Se recomienda agregar pegs padres a las capas de dibujo, que son capas de ruta que permiten agregar
fotogramas clave para modificar las posiciones de las piezas a lo largo del tiempo. No es obligatorio, pero si util
que los dibujos y los fotogramas clave estén separados.

C6mo emparentar pegs a capas de dibujo

1. Enlavista de linea de tiempo, seleccione todas las capas.

ar
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2. Enlabarra de herramientas Timeline Layer (Capa de linea de tiempo), haga clic en el boton Add Parent Peg
(Agregar peg padre) (. para agregar un peg padre a todas las capas seleccionadas.

)

ok

Coémo emparentar capas

Harmony permite extender las técnicas de rigging mas alla de los limites normales y establece nuevas normas.
Puede crear jerarquias sin encapsular piezas unas dentro de otras mediante la creacion de una estructura vinculada
entre capas.

Debe crear una jerarquia en los brazos y piernas, y mantenerlos separados del cuerpo. Asi contara con mas libertad
en la animacién y cuando tenga que escalar o sesgar el torso, no afectara a todo el cuerpo.
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| <= Jerarquia de cabeza

Jerarquia de brazo B

derecho <@ Jerarquia de brazo izquierdo

Torso y caderas independientes

Jerarquia de pierna derecha = <g}— Jerarquia de pierna izquierda

Creacién de una jerarquia en la vista de linea de tiempo

1. Arrastre la pieza hija (mano) y coléquela SOBRE la pieza padre (antebrazo). A continuacion, puede arras-

trar la pieza padre (antebrazo) sobre otra pieza padre (brazo superior).

Sin pegs

trn_cuff |

+
+
+
+
+
+
+
+
+

» Puede desconectar una capa de su capa padre manteniendo presionada la tecla MayUs y arrastrando

la capa padre lejos de la capa hija. Coloque los seleccionados entre las otras capas.
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Peg maestro

Cuando anime el personaje, es probable que deba cambiar el tamafio y cambiarlo de posicién para que encaje enla
escena. Cuando tenga que reducir o mover el personaje, es una buena idea enganchar (conectar) toda la marioneta
a una trayectoria.

Al conectar la marioneta a un peg, podra escalarla y cambiarla de posicién sin tener que hacerlo en las distintas
partes y piezas. Solo una capa contendra la informacién de posicion, lo que facilita la modificacion y el control de la
animacion.

Adicién de un peg maestro

1. Enlavista de linea de tiempo, seleccione la capa superior para que quede emparentada a un peg. Debe selec-
cionar una capa para poder agregar un peg a la escena.

2. Enlavistade linea de tiempo, haga clic en el boton Add Peg (Agregar peg) (- .

Se agrega a la linea de tiempo un nuevo peg al que queda emparentada la capa seleccionada.

Asigne el nombre Master mas el nombre del personaje al nuevo peg.

4. Enlavista de linea de tiempo, seleccione todas las capas que desee conectar al nuevo peg. Recuerde que
dicho peg ya tiene un elemento padre.

5. Arrastre la seleccion SOBRE la capa del peg para emparentar todas las piezas del personaje al peg. Si se
agregan capas encima de las capas que ya tienen padres, mueva dicha capa con padres de nuevo a la parte
superior de la pila de capas.
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Capitulo 11: Uso de deformadores

La tecnologia de deformacion permite deformar dibujos de mapa de bits y vectoriales durante un periodo de tiempo.
Puede vincular deformadores para crear una jerarquia de deformacion. Puede deformar un personaje compuesto por
una o varias capas de dibujo o imagen, y hacer que se mueva como si fuese una marioneta Cut-out.

Acerca de los efectos de deformacion

Las deformaciones permiten animar un grafico de mapa de bits o vectorial, incluidos los gradientes y texturas. Las
deformaciones actian como un esqueleto con miembros y articulaciones que puede doblar, cambiar de formay
curvar. Puede deformar un personaje compuesto por una o varias capas de dibujo o imagen, y hacer que se mueva
como si fuese una marioneta Cut-out. Un esqueleto de deformacién esta compuesto por nodos de deformacion, que
son las distintas piezas (representadas aqui como capas o nodos) necesarias para articular o deformar los dibujos,
como una serie de huesos o huesos de juego (consulte ).

Deformador de huesos

== Hueso

4 = Arficulacion incluida

o>

Hueso =

La deformacion de hueso permite crear una estructura de esqueleto en la que el hueso padre mueva el hijo. La
deformacion de hueso resulta util al animar las extremidades de un personaje, como los brazos o las piernas,
agregando fluidez y naturalidad a la animacion. Se puede manipular para rotar un miembro en una articulacion y
también para acortar o alargar las extremidades de un miembro. También es muy practica para doblar el torso.

NOTA: Si esta creando un rig para utilizarlo en un juego, utilice la deformacion Game Bone (Hueso de juego).

51



Capitulo 11: Uso de deformadores

Deformador de hueso de juego

== Hueso

iy == Articulacion incluida

L

Hueso ==

La deformacion de hueso de juego es muy parecida a la deformacion de hueso, y permite crear una estructura de
esqueleto en la que el hueso padre mueva el hijo. La diferencia es que la deformacion de hueso de juego esta
optimizada para exportarla a motores de juego, principalmente a Unity.

La deformacioén de hueso de juego se utiliza principalmente al animar las extremidades de un personaje, como los
brazos o las piernas, agregando fluidez y naturalidad a la animacién. La deformacion de hueso de juego se puede
manipular para rotar un miembro en una articulacién y también para acortar o alargar las extremidades de un
miembro. También es muy util para doblar el torso.

La principal diferencia entre las deformaciones de hueso y de hueso de juego es que la deformacién de hueso de
juego no tiene el parametro Bias (Sesgo) . El resultado renderizado también es distinto para los pliegues de la
articulacion. Aparecen ligeramente redondeados.

Rigging
Mediante la herramienta Rigging, puede crear rapidamente un rig de deformacion bésico.

A medida que cree las cadenas, se mostraran los controles. Sin embargo, cuando cierre el proyecto, se
desactiva la visualizacién de los controles de deformacion. Al volver a abrir el proyecto, puede mostrar todos los
controles o solo algunos de ellos (consulte Visualizacion de los controles de deformacion en la pagina 58.

La permite afiadir manualmente los nodos necesarios para crear el esqueleto de deformacién. Se encuentran
disponibles nodos adicionales, como la salida de cinematica.

Seleccién de un elemento para agregar deformacién a

1. Enla barra de herramientas Deformation (Deformacion), haga clic en la herramienta Rigging {T

2. Enlavista de camara o linea de tiempo, seleccione el elemento al que desea agregar la deformacion. Al
seleccionar un nodo de dibujo, los componentes de deformacién se agregaran automaticamente sobre el
nodo de dibujo. Al seleccionar un nodo de peg, los componentes de deformacion se agregaran debajo del

peg.
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NOTA: No coloque nunca un nodo de deformacién sobre un nodo de peg. Si hay un peg debajo de un nodo de
deformacién (hueso, hueso de juego, etc.) puede producirse un resultado imprevisto. La animacién del peg movera
la imagen fuera de la zona de deformacion definida. Lo mismo se aplica a las animaciones creadas en la propia
capa de dibujo. Una capa de dibujo tiene un peg integrado.

3. Enlavista de camara, cree el rig. Consulte los siguientes procedimientos para aprender a agregar un tipo de
deformacion especifico.

Adicién de una cadena de deformacién de hueso y hueso de juego

1. Unavez que se encuentren seleccionados el elemento y la herramienta Rigging, en la vista de propiedades
de la herramienta, active el modo Bone (Hueso) £, o el modo Game Bone (Hueso de juego) segun el obje-

tivo.

2. Coloque el cursor en la raiz del dibujo o del grupo de dibujos, haga clic una vez y suéltelo. Por ejemplo, en el
hombro.

-

3. Haga clic de nuevo en la ubicacion en la que desea que termine el primer hueso y que comience el segundo
hueso. Se insertara automaticamente un punto de control de articulaciéon entre cada hueso que cree. Tenga
en cuenta que los parametros de articulacion forman parte de los nodos de hueso y de hueso de juego desde
Harmony 12.

4. Repitalo hasta que haya terminado de crear la cadena de huesos.
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5. Sinecesita insertar un hueso entre los existentes, mantenga pulsada la tecla Alt. Cuando se muestre el
cursor Insert Bone (Insertar hueso), haga clic en el segmento de hueso existente en la ubicacion en la que
desea agregar un hueso adicional.

« Tenga en cuenta que puede hacer clic en el punto de articulacion del hueso para iniciar una
nueva cadena de hueso a partir de ese punto. Una vez que esté seleccionado el punto de la
articulacion (blanco), haga clic en la ubicacién en la que desee agregar un hueso y se creara
una nueva cadena de huesos, que quedara emparentada a la anterior.

« Cuando varias cadenas controlan el mismo dibujo o grupo de dibujos, se crea auto-
maticamente un nodo de composicion de deformacion y aparece la vista de linea de tiempo.
En la seccion de vinculos adicionales de la vista de linea de tiempo, puede ver los nodos
que estan conectados con la composicion de deformacion.
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6. Con los nodos de deformacion aun seleccionados, en la barra de herramientas Deformation (Deformacién),
haga clic en el boton Reset Current Keyframe (Restablecer fotograma clave actual) CE.?* . La posicion de
reposo actual se establecera como la del fotograma actual.

Ajuste de la cadena de deformacion
Una vez que haya creado la cadena de deformacion, puede optimizar su posicion para que se ajuste al elemento que

va a deformar.

Configuracién de cadenas de deformacién de hueso y hueso de juego

1. Enlavista de linea de tiempo, seleccione los nodos que desea definir.

2. Enlabarra de herramientas Deformation (Deformacion), haga clic en el botén Show Selected Deformers and
Hide All Others (Mostrar deformadores seleccionados y ocultar el resto) ©— para mostrar los controles de

deformacion en la vista de camara. De este modo también se ocultan todos los controles de deformacion
visualizados

3. Enlabarra de herramientas Deformation (Deformacién), haga clic en la herramienta Rigging iT-

La cadena cambia de verde a rojo. Una cadena verde indica que la marioneta esta en modo de animacion.
Una cadena roja indica que la marioneta esta en posicién de reposo. Asegurese de que la cadena sea roja.

: /
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4. Enlavista de camara, configure la cadena de deformacion.

» Gire el primer hueso para cambiar el angulo de la cadena.
q

|

il

» Ultilice el control raiz para cambiar de posicion (compensar) toda la cadena.

)

[

»  Utilice puntos de control para cambiar de posicién las articulaciones. De este modo se alargara,
acortara o cambiara la direccién del hueso, y se compensaran los demas secundarios.
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» Utilice el control de la articulacion (cuadrado) para cambiar el tamario de la misma. Por motivos de
calidad, se recomienda que el diametro de la articulacion se ajuste al de la parte que controla.

)

Repita el proceso hasta que todas las articulaciones y huesos de la cadena estén correctamente alineados
con el elemento con el que estan vinculados. También puede definir parametros adicionales en la ventana
Layer Properties (Propiedades de capa).

Con los nodos de deformacion aun seleccionados, en la barra de herramientas Deformation (Deformacion),
haga clic en el boton Reset Current Keyframe (Restablecer fotograma clave actual) CI.L? . La posicion de

reposo actual se establecera como la del fotograma actual.

Utilice la herramienta Transform (Transformar) {°1. Para obtener resultados optimos, asegurese de que la
articulacion tenga aproximadamente el mismo tamanio que el dibujo.

Si necesita insertar un hueso entre los existentes, mantenga pulsada la tecla Alt. Cuando se muestre el cur-
sor Insert Bone (Insertar hueso), haga clic en el segmento de hueso existente en la ubicacion en la que desea
agregar un hueso adicional.
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Visualizacion de los controles de deformacion

Antes de manipular el deformador fuera del modo de Rigging, debe visualizar los controles de deformacion.

Si acaba de crear el rig de deformacion, los controles alin seguiran apareciendo. Sin embargo, al cerrar el
proyecto, los deformadores se desactivan. Al volver a abrir un proyecto, debe visualizar los controles para poder
ver los que necesita durante la animacion.

Visualizacion de los controles de deformacién seleccionados

1. Enlas vistas de cdmara, linea de tiempo, seleccione la capa de dibujo o los nodos que desea mostrar.

2. Realice una de las siguientes acciones:

» Enla barra de herramientas Camera (Camara), haga clic en el boton Show Control (Mostrar control)

» En el menu superior, seleccione View > Show > Control (Ver > Mostrar > Control).
» Pulse Mayus + F11.

Visualizacién de los controles de deformacién seleccionados y ocultacién de todos los demas

1. Enlas vistas de camara, linea de tiempo, seleccione la capa de dibujo o los nodos que desea mostrar.

2. Enlabarra de herramientas Deformation (Deformacion), haga clic en el botén Show Selected Deformers
and Hide All Others (Mostrar deformadores seleccionados y ocultar el resto) <.

Los controles de deformacion seleccionados aparecen en la vista de camara y los demas quedan ocultos.

Visualizacién de todos los controles de deformacién al mismo tiempo

1. Enlavista de linea de tiempo, seleccione Edit > Select All (Editar > Seleccionar todo) en el menu superior
para seleccionar todos los nodos o pulse Ctrl + A (Windows/Linux) o 3£ + A (Mac OS X).

2. Enla barra de herramientas Camera (Camara), haga clic en el botén Show Control (Mostrar control) o}
pulse Mayus + F11.

Se mostraran todos los controles de deformacion de la escena.

Coémo ocultar los controles de deformacién

1. Realice una de las siguientes acciones:
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» Enlabarra de herramientas Camera (Camara), haga clic en el boton Hide All Controls (Ocultar todos los
controles)

» En el menu superior, seleccione View > Hide All Controls (Ver > Ocultar todos los controles).
» Pulse Mayus + C.

Animacion

Los controles para animar las deformaciones funcionan del mismo modo que los utilizados para configurar las
cadenas. Solo debe crear fotogramas clave y colocar los puntos de control.

Animacién de deformaciones de hueso y hueso de juego

1. Enlavista de linea de tiempo, vaya al fotograma en el que desea crear la primera pose de animacion.

2. Enla barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) 171 .

3. Sidesea crear fotogramas clave de animacion, active el modo Animate (Animar) en la barra de herra-
mientas Tools (Herramientas).

4. Realice una de las siguientes acciones:

« Enlabarra de herramientas Timeline (Linea de tiempo), haga clic en el botén Add Keyframe
(Agregar fotograma clave) # .

« Haga clic con el boton derecho y seleccione Add Keyframe (Agregar fotograma clave).
o PulseFB6.

Se agrega un fotograma clave al fotograma actual.

5. Enlavista de linea de tiempo, seleccione los nodos que desea animar (consulte Visualizacion de los con-
troles de deformacion en la pagina 58.

6. En labarra de herramientas Deformation (Deformacion), haga clic en el botén Show Selected Deformers and
Hide All Others (Mostrar deformadores seleccionados y ocultar el resto) -©— para mostrar el deformador de la
pieza seleccionada.

7. Enlavista de camara, realice lo siguiente:

« Gire el primer hueso para rotar el miembro.
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« Gire los demas huesos para doblar el miembro.

« Utilice el control raiz para cambiar de posicion (compensar) toda la cadena.

« Utilice puntos de control para cambiar de posicion las articulaciones. De este modo se alar-
gara, acortara o cambiara la direccion del hueso, y se compensaran los demas hijos.
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« Utilice el control de la articulacién (cuadrado) para cambiar el tamafio de la misma. Por motivos
de calidad, se recomienda que el diametro de la articulacién se ajuste al de la parte que con-
trola.

8. Enlavista de linea de tiempo, vaya al fotograma en el que desea establecer la siguiente pose clave. Debera
expandir la exposicién para ver los dibujos mas abajo en la vista de linea de tiempo.

9. Agregue un fotograma clave en el fotograma actual realizando una de las siguientes acciones:

« Enla barra de herramientas Timeline (Linea de tiempo), haga clic en el botén Add Keyframe
(Agregar fotograma clave) # .

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.

10. Repitalos pasos anteriores para animar el personaje.

También puede manipular el deformador escribiendo valores directamente en las propiedades de capa de los
nodos del efecto de deformacién.
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form Parameters

Deform Parameters
Offset

Propiedades de capa Propiedades de capa de hueso de juego
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Capitulo 12: Animacién de un personaje Cut-out
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Harmony ofrece algunas fantasticas herramientas para animar marionetas. Puede crear una animacioén sencilla con
la herramienta Transform (Transformar), y también crear animacién avanzada utilizando cinematica de avance y
cinematica inversa. Harmony cuenta con funciones de papel cebolla e intercambio de imagenes avanzadas que
ayudan a realizar una animacion de manera eficiente y rapida. Para contar con libertad de animacién, puede mezclar
varias técnicas de animacion distintas, como rigging simple, jerarquia y animacion de simbolos.

Creacion de una animacion Cut-out simple

En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) £°% o
pulse Mayus + T.

En la barra de herramientas Tools (Herramientas), active el modo Animate (Animar) de modo que todo lo
gue mueva se ajuste al fotograma clave automaticamente.

En el menu superior, seleccione Animation > Stop-Motion Keyframe (Animacién > Fotograma clave de
Stop-motion) de modo que la interpolacién no se cree automaticamente entre fotogramas clave.

En la vista de linea de tiempo, contraiga el personaje.

Para garantizar que no se mueve nada en la nueva pose, en la vista de linea de tiempo, seleccione el foto-
grama correspondiente a la pose, haga clic con el botdn derecho y seleccione Add Keyframe (Agregar foto-
grama clave) o pulse F6.

En la vista de camara, seleccione las partes que desea animar.
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8. Utilice la herramienta Transform (Transformar) {* para rotar, sesgar, escalar o trasladar la seleccion a su
nueva posicién. Para rotar la pieza, situe el cursor ligeramente fuera de una esquina hasta que vea el cur-
sor de rotacion.

Un nuevo fotograma clave aparece en la vista de linea de tiempo si no habia creado uno con anterioridad.
Cree siempre el fotograma clave en primer lugar.

9. Enlabarra de herramientas Tools (Herramientas), active la funcién Onion Skin (Papel cebolla) f; .

10. Enlavista de linea de tiempo, vaya al fotograma en el que desea establecer el segundo fotograma clave.
Debera expandir la exposicion para ver los dibujos mas abajo en la vista de linea de tiempo.

11. Para garantizar que no se mueve nada en la nueva pose, en la vista de linea de tiempo, seleccione el foto-
grama correspondiente a la pose, haga clic con el botén derecho y seleccione Add Keyframe (Agregar
fotograma clave) o pulse F6.

12. Enlavista de camara, anime el personaje.
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Padre
seleccionado

13. Repita este proceso para todas las poses.

Seleccién de la capa padre o hija

En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar)

En la vista de propiedades de la herramienta Transform (Transformar), asegurese de que esté desactivado el
modo Peg Selection (Seleccion de peg) -

3. Enlavista de camara de linea de tiempo, seleccione una capa conectada a una jerarquia.

=
e

4

4. En el menu superior, seleccione Animation > Select Parent (Animacién > Seleccionar padre) o pulse B para
seleccionar la capa padre. Seleccione Animation > Select Child (Animacion > Seleccionar hijo) o pulse

Mayus + B para seleccionar la capa hija.

—
™ X
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Definicion de la velocidad en varios pardmetros

1. Enlavista de linea de tiempo, seleccione un fotograma clave de una o varias capas.

NOTA: Solo se tiene en cuenta el primer fotograma clave seleccionado en cada capa al usar la funcion Set Ease
for Multiple Parameter (Definir velocidad para varios parametros). Si hay muchos fotogramas clave seleccionados
en la misma capa, los valores de velocidad se aplicaran solo al primero y el resto se ignorara.

2. Realice una de las siguientes acciones:
» Enlavista de linea de tiempo, haga clic con el boton derecho y seleccione Set Ease For Multiple
Parameters (Definir velocidad para varios parametros).

» Enlabarra de herramientas Timeline (Linea de tiempo), haga clic en el boton Set Ease For Multiple
Parameters (Definir velocidad para varios parametros) -~ . Si el boton no esta en la barra de

herramientas, puede agregarlo mediante el administrador de barras de herramientas. Haga clic con el
botén derecho en la barra de herramientas y seleccione Customize (Personalizar).

Se abre el cuadro de dialogo Set Ease For Multiple Parameters (Definir velocidad para varios pardmetros).

Grafico =

EEEEEE

3. Enel grafico, tire del controlador de la curva Bézier para ajustar la velocidad de todas las funciones selec-
cionadas.
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Para aplicar estos parametros de velocidad unicamente a un tipo de funcién determinado, como Rotation
(Rotacion) o Scale (Escala), en la seccion Filters (Filtros), anule la seleccion de los tipos de funcién a los que
no desee que se apliquen.

4

Motion (Movimiento): aplica los pardmetros de velocidad a las funciones Position X (Posicion X),
Position Y (Posicién Y), Position Z (Posicion Z) y 3D Path (Ruta 3D) seleccionadas.

Rotation (Rotacion): aplica los parametros de velocidad a las funciones de angulo seleccionadas.
Scale (Escala): aplica los parametros de velocidad a las funciones de escala seleccionadas.
Skew (Sesgar): aplica los parametros de velocidad a las funciones de inclinacion seleccionadas.

Morphing: aplica los parametros de velocidad a las funciones de velocidad de morphing seleccionadas.
Tenga en cuenta que se aplica cuando la funcion Morphing Velocity (Velocidad de morphing) de la
ventana Layer Properties (Propiedades de capa), no es la velocidad de morphing basica en la vista de
propiedades de la herramienta.

Other (Otras): aplica los parametros de velocidad a todas las demas funciones seleccionadas, como
todas las funciones creadas para animar parametros de efecto.

También puede ajustar la velocidad introduciendo valores en los campos Time Ratio (Ratio de tiempo) y
Value Ratio (Ratio de valor). Los valores se calculan como un porcentaje.

»

En los campos Left Time Ratio (Ratio de tiempo izquierdo) y Right Time Ratio (Ratio de tiempo derecho),
escriba el valor como porcentaje correspondiente al tiempo que desea que dure la velocidad. El valor debe
estarentreel 0 % y el 100 %.

En los campos Left Value Ratio (Ratio de valor izquierdo) y Right Value Ratio (Ratio de valor derecho),
escriba el valor como porcentaje correspondiente a la intensidad que desea que tenga la desaceleracion.
El valor debe estarentre el 0 % y el 100 %.

Silos valores Time Ratio (Ratio de tiempo) y Value Ratio (Ratio de valor) son iguales, el movimiento sera
lineal.

Haga clic en uno de los siguientes botones:

>

4

Apply (Aplicar): aplica los parametros de velocidad a los fotogramas clave seleccionados.

Apply/Previous (Aplicar/anterior): aplica los parametros de velocidad a los fotogramas clave
seleccionados y automaticamente se selecciona seleccione el fotograma clave anterior en la linea de
tiempo.

Apply/Next (Aplicar/siguiente): aplica los parametros de velocidad a los fotogramas clave seleccionados
y automaticamente se selecciona el fotograma clave siguiente en la linea de tiempo.

Close (Cerrar): cierra el cuadro de dialogo. Si no ha aplicado las modificaciones, se cancelaran.
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Capitulo 13: Creacidn de plantillas

Puede crear una plantilla a partir de una capa o de celdas. Puede almacenar como una plantilla cualquier elemento
disponible en la vista de linea de tiempo.

Al crear una plantilla seleccionando una capa, se incorporaran la capa y todos los dibujos creados en la misma,
incluso si no estan expuestos en la vista de linea de tiempo. La seleccion de celdas solo guardara en la plantilla
esos dibujos especificos.

Creacion de una plantilla desde la vista de linea de tiempo

1. Enlavista de linea de tiempo, seleccione varias celdas o capas.
2. Enlavista de libreria, seleccione una carpeta para almacenar la plantilla.

3. Siuna carpeta de libreria esta bloqueada, haga clic con el boton derecho y seleccione Right to Modify (Dere-
cho para modificar).

4. Arrastre la seleccién a la carpeta Stage Library (Libreria de Stage Premium) o a cualquier otra carpeta.

Library | =4 |%

TATTWI

5. En el cuadro de didlogo Rename (Cambiar nombre), asigne un nombre a la nueva plantilla.

Para cambiar el nombre de una plantilla una vez creada, haga clic con el botén derecho en el simbolo y
seleccione Rename (Cambiar nombre).

6. Haga clic en OK (Aceptar).
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Importacién de una plantilla a la vista de linea de tiempo o de camara

1. Enlavistade libreria, seleccione la plantilla que desea importar.
2. Arrastre la plantilla seleccionada a la vista de camara o a la izquierda de la vista de linea de tiempo.

3. También puede arrastrar una plantilla a la derecha de la vista de linea de tiempo y en capas existentes sila
estructura de capas es igual que la existente.
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Capitulo 14: Configuracion de una escena

La configuracion de una escena se puede comparar con la construccion de la escenografia para un programa de
television. Este es el punto en el que coloca el elemento de escena, como el encuadre de camara, los elementos de
fondoy los personajes.

Colocacion de la camara

La accion de la escena tiene lugar dentro del encuadre de camara, de modo que es muy importante configurarlo
correctamente. Puede ajustar la resolucion de la camara y otros parametros en la ventana Scene Settings
(Configuracion de escena). Consulte el capitulo /nicio de Harmony de la Guia de fundamentos para obtener mas
informacion.

La capa de camara es estatica, lo que significa que si necesita animarla, debe agregar un peg.

Debe agregar a la escena una capa de camara, de modo que pueda editar el encuadre de camara. Solo puede ver
una camara cada vez. Si agrega a la escena varias camaras, puede utilizar la lista de camaras para seleccionar la
gue esta activa. Puede utilizar esta funcion si aun esta trabajando en la composicion de escena y tiene distintos
encuadres de camara para probar.

Puede cambiar la posicién del encuadre de cdmara directamente en la vista de camara utilizando las herramientas
de animacién avanzada. Otra forma de configurar el encuadre de camara es escribiendo las coordenadas
directamente en las propiedades de la camara. Al hacerlo, la camara se coloca en el punto exacto en el cual desea
gue esté en lugar de determinarlo visualmente.

Puede restablecer la camara facilmente a su posicion original. Mediante el comando de restablecimiento, puede
restablecer el valor del elemento seleccionado al valor inicial de la herramienta activa. Por ejemplo, si est4 activa la
herramienta Rotate (Rotar) OF el angulo de transformacion se restablecera a 0y, si esta activa la herramienta
Transform (Transformar) 1”1, se restableceran todos los valores de parametros.

Adicién de una camara en la vista de linea de tiempo

1. Realice una de las siguientes acciones:
» Enlavista de linea de tiempo, haga clic en el botén Add Layer (Agregar capa) y seleccione Camera
(Camara).
» En el menu superior, seleccione Insert > Camera (Insertar > Camara).
Se agrega a la escena una nueva capa de camara y aparece en la vista de linea de tiempo.

NOTA: No puede agregar una camara dentro de un simbolo.
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Cambio de lugar del encuadre de caAmara directamente en la vista de cAmara

1. Enla barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar)

2. Realice una de las siguientes acciones:
»  En el menu superior, seleccione Animation > Tools > Translate (Animacion > Herramientas >
Traslacion).

» Enla barra de herramientas Advanced Animation (Animacion avanzada), haga clic en la herramienta
Translate (Traslacion) (-I—).

» PulseAlt + 2.

3. Enlavista de camara, haga clic en el encuadre de camara (rectangulo delgado) para seleccionarlo. Tam-
bién puede seleccionar la capa de camara en la vista de linea de tiempo .

Se resalta el encuadre de camara seleccionado.

4. Arrastre el encuadre de camara a una nueva posicion.
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5. Pararotar el encuadre de camara, realice una de las siguientes acciones para seleccionar la herramienta
Rotate (Rotar):

» En el menu superior, seleccione Animation > Tools > Rotate (Animacion > Herramientas > Rotar).

» Enlabarra de herramientas Advanced Animation (Animacion avanzada), seleccione la herramienta
Rotate (Rotar) -

» PulseAlt + 3.

6. Enlavista de camara, arrastre para rotar el encuadre de camara hasta que alcance el dngulo de rotacién
deseado.

Restablecimiento de la posicidon de la camara

1. Enla barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) {*1 o
pulse Mayus + T.

2. Enlavista de linea de tiempo o de camara, seleccione la capa de camara.
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3. Enel menu superior, seleccione Animation > Reset (Animacién > Restablecer) o pulse Mayus + R.

La camara vuelve automaticamente a su posicion original.

Colocacion de objetos

La configuracion de la escena también implica la colocacion de los distintos elementos de la escena dentro del
encuadre de camara.

Paneo de una capa con la herramienta Transform (Transformar)

1. Enla barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar)

2. Enla barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) 1}
o pulse Mayus + T.

3. Enlavista de propiedades de la herramienta, asegurese de que esté desactivada la opcion Peg Selection
Mode (Modo de seleccion de peg) -

4. Enlavista de camara, seleccione una capa de dibujo y arrastre la seleccién a una nueva area. Puede
seleccionar varias capas y cambiarlas de posicién al mismo tiempo. Mantenga pulsada la tecla Mayus y
seleccione las distintas capas.

Rotacién de una capa con la herramienta Transform (Transformar)

1. Enla barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar)

2. Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) i3
o pulse Mayus + T.

3. Enlavista de propiedades de la herramienta, asegurese de que esté desactivada la opcion Peg Selection
Mode (Modo de seleccion de peg) e -

4. Enlavista de camara, seleccione una capa de dibujo.

5. Coloque el puntero fuera de una esquina del cuadro de limite y arrastrelo para rotar.
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NOTA:

Al transformar una capa, puede visualizar un controlador de rotacion en el cuadro de limite. En el cuadro de dialogo
Preferences (Preferencias), seleccione la pestafia Camera (Camara) y, a continuacién, seleccione la opcion Use
Rotation Lever with Transformation Tools (Usar palanca de rotacion con herramientas de transformacién). Esta
preferencia esta desactivada de forma predeterminada.

2 ‘Controlador de rotacidn

Escalado de una capa con la herramienta Transform (Transformar)

1. Enla barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar)

2. Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) "1 o
pulse Mayus + T.

3. Enlavista de propiedades de la herramienta, asegurese de que esté desactivada la opcion Peg Selection
Mode (Modo de seleccion de peg) /. -

4. Enlavista de camara, seleccione una capa de dibujo y empuije o tire del punto de control lateral, superior o de
esquina. Mantenga pulsada la tecla Mayus para bloquear la proporcién de la seleccion.
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3

Sesgo de una capa con la herramienta Transform (Transformar)

1. Enla barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar)

2. Enla barra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) 13

o pulse Mayus + T.

3. Enlavista de propiedades de la herramienta, asegurese de que esté desactivada la opcion Peg Selection

Mode (Modo de seleccion de peg) -

4. Enlavista de cdmara, seleccione una capa de dibujo.

5. Situe el puntero entre dos puntos de control y arrastrelo hacia los lados o arriba y abajo.

Dibujo original Cursor colocado entre Cursor colocado enfre
puntos de control y puntos de control y
arrastrado hacia arriba arrastrado hacia los lados

Cambio de posicion del pivote

Las transformaciones, como rotar, escalar, sesgary voltear, se realizan respecto a la posicién de pivote. Puede
cambiar la posicion de este punto de pivote a cualquier lugar utilizando las herramientas de animacion avanzada.

Cambio de posicién permanente del punto de pivote

1. Enlabarra de herramientas Advanced Animation (Animacién avanzada), seleccione la herramienta Trans-
late (Traslacion) (_I*, Rotate (Rotar) . Scale (Escalar) [7] o Skew (Sesgar) /7.

2. Enlavista de camara, Ctrl + clic (Windows/Linux) o 38 + clic (Mac OS X) para seleccionar el elemento.

El punto de pivote aparece en la vista de camara.
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FPunto de pivote

3. Arrastre el punto de pivote a una nueva posicion.

Todas las transformaciones, incluidas las existentes, se volvera a calcular conforme a esta nueva posicién
de pivote.
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Capitulo 15: Animacioén de objetos y de la camara

Cuando se trata de animar objetos, lo hara en capas creando rutas de movimiento. También puede animar la
camara, que es igual que cualquier otro objeto que puede animar.

Animacién de una capa

Puede crear la ruta de movimiento directamente en capas (capas animadas).

Puede controlar y definir una trayectoria utilizando varios parametros distintos, incluidos:
» Posiciones X, Yy Z (ruta 3D o posiciones separadas)
+  Angulo (rotacién)
+ Sesgar
+ Escalas XeY

Cada pardmetro tiene su propia curva de funcién, en la cual puede agregar fotogramas clave y controlar la velocidad.
Si no esta familiarizado con los graficos y curvas de funcion, se trata de herramientas de facil uso para controlar
visualmente las trayectorias de las vistas de camaray linea de tiempo.

Expande parametros

Parametros Valores

Animacién de una capa

1. Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) §°1 o
pulse Mayus + T.
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2. Enlavista de propiedades de la herramienta, asegurese de que esté desactivada la opcién Peg Selection
Mode (Modo de seleccion de peg) -

3. Enlabarra de herramientas Tools (Herramientas), active el modo Animate (Animar) -~ . Esto permite
crear fotogramas clave en el fotograma actual al mover objetos.

4. Enlavistade linea de tiempo, vaya al primer fotograma.

5. Enlavista de camara, seleccione el elemento que desea animar y muévalo a su primera posicion.

a-—

Se crea un fotograma clave en el primer fotograma de la vista de linea de tiempo.

10 20 30 40 =l EL
T o I I A S I B U B

Wil

Fotograma clave

6. Enlavista de linea de tiempo, vaya al fotograma en el que desea establecer la segunda posicion.

7. Enlavista de camara, mueva el elemento a su segunda posicion.
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Se crea un segundo fotograma clave en la vista de linea de tiempo.

Fotograma clave

8. Reproduzca g suanimacion.

Para ver las animaciones de movimiento en las vistas superior, lateral o de perspectiva mientras las
reproduce, debe activar la opcion Playback (Reproducir). En el menu superior, seleccione Play > Enable
Playback > Top View (Reproducir > Activar reproduccion > Vista superior) o Side View (Vista lateral) o
Perspective View(Vista de perspectiva).

Animacion de la camara

La camara se trata del mismo modo que cualquier otro elemento. Puede utilizar las mismas herramientas y modos
de seleccién para desplazarla o animarla, pero la camara es un objeto estatico. Para animar la camara, debe
conectarla a una capa de peg. Un peg es una capa de trayectoria.

Mientras realiza movimientos de camara, puede utilizar las vistas superior, lateral y de camara.

Apertura de las vistas superior y lateral

1. Realice una de las siguientes acciones:

» En el menu superior, seleccione Windows > Top (Ventanas > Superior) o Side (Lateral).

» Desde cualquier vista que ya esté abierta, haga clic en el boton Add View (Agregar vista) situado en
la esquina superior derecha y seleccione Top (Superior) o Side (Lateral).

Coémo agregar una camara y emparentarla a un peg

1. Siaun no tiene una capa de camara, realice una de las siguientes acciones:

»  En el menu superior, seleccione Insert > Camera (Insertar > Camara).
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» Enlabarra de herramientas Layer (Capas), haga clic en el boton Add Layers (Agregar capas) y
seleccione Camera (Camara).
Se agrega a la escena una nueva capa de camara y aparece en la vista de linea de tiempo.

2. Enlavista de linea de tiempo, seleccione la capa de camara.

3. Enlabarra de herramientas Layer (Capas), haga clic en el boton Add Peg (Agregar peg) (- .

Aparece una capa de peg directamente sobre la capa de camara, que se conecta a ella automaticamente.

La capa de peg toma automaticamente el nombre de la camara y agrega el sufijo -P para indicar que se
trata de una capa de peg, por ejemplo, Camera-P (Camara-P).

Capa de peg contraida

Capa de peg expandida

Si la nueva capa de pivotes no aparecia directamente encima de la camara, puede que haya hecho clic en
algun otro lugar de la escena que desactivase la capa a la que desea agregar la capa de peg. Para
resolverlo:

» Seleccione la capa de camaray arrastrela y coléquela debajo de la nueva capa de peg. O bien, elimine
la capa de peg mal colocada, seleccione la capa de camara y haga clic de nuevo en el botén Add Peg
(- (Agregar peg).

» Puede desconectar una capa de su capa padre manteniendo presionada la tecla MayUs y arrastrando
la capa padre lejos de la capa hija. Coloque los seleccionados entre las otras capas.

Animacion de la cAmara

1. Enla barra de herramientas Tools (Herramientas), active el modo Animate (Animar)

2. Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar) i3
o pulse Mayus + T.

3. Enellado derecho de la vista de linea de tiempo, en la capa de peg de camara, seleccione el fotograma en
el que desee que comience el movimiento de camara.

4. Realice una de las siguientes acciones:

» Enlabarra de herramientas Timeline (Linea de tiempo), haga clic en el botén Add Keyframe (Agregar
fotograma clave) # .
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» Haga clic con el boton derecho y seleccione Insert Keyframe (Insertar fotograma clave).
» Pulse F6.

Aparece un fotograma clave en dicha celda. Los fotogramas que preceden a este fotograma clave
mantendran la misma posicion de camara que este fotograma clave.

5. Enlas vistas superior, lateral o de camara, seleccione la camara (el cono grande con forma de V) y muévala
a la posicion deseada. En la vista de camara, la camara esta representada por un marco delgado. Debe hacer
clic directamente en uno de los bordes.

6. Enlavistade linea de tiempo, haga clic en otra celda un poco mas abajo para indicar dénde terminara el movi-
miento de camara.

7. Seleccione la camara en la vista de camara, superior o lateral, y muévala a la posicion deseada.

Aparece un segundo fotograma clave y se crea una linea entre los dos fotogramas para indicar que el
movimiento posterior entre los fotogramas se va a calcular y que lo renderizara el programa.

8. Reproduzca g suanimacion.
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Capitulo 16: Creacion de un multiplano

Para construir un multiplano, debe imaginarse cdmo es un entorno real. Mire la imagen de fondo e imagine una
camara que se mueve por el espacio. Tenga en cuenta que los objetos de la imagen se mueven a distintas
velocidades segun donde se encuentren en relacion a la lente de la camara.

Para construir un multiplano, es necesario comprender el fondo de la escena, asi como la posicién de los elementos
en las distintas capas.

Por ejemplo, en el fondo ilustrado anteriormente, los objetos principales que se deben separar son:
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1. Helecho
2. Torre delantera

3. Segunda torre

4. Luna
5. Estrellas
6. Cielo

Aunque la parte inferior de la torre queda oculta detras de la planta y la escalera, cada una de las capas multiplano
debe ser un dibujo completo. Esto se debe a que las partes ocultas pueden aparecer durante un movimiento de
camara mas adelante en la escena.

Puede colocar capas en el eje Z utilizando las vistas lateral y superior.

Al colocar el elemento mas cerca de la camara, éste parece mas grande. También puede acercar los elementos a
camara o alejarlos de ella mientras mantiene la misma proporcion de tamafo en la vista de camara.

Es buena idea mantener la vista de camara abierta para ver el aspecto de la escena mientras coloca los
elementos en las vistas superiory lateral.

. N

Colocacidn de un elemento en las vistas superior y lateral

NOTA: Antes de distribuir capas a lo largo del eje Z utilizando las vistas superior y lateral, anule la seleccién de la
opcion No Z Dragging (No arrastrar en Z) seleccionando Animation > No Z Dragging (Animacion > No arrastrar
en Z). Esta opcion esta desactivada de forma predeterminada.

1. Para mantener la escala visual de la vista de camara a medida que mueve el elemento, realice una de las
siguientes acciones:

» Enlabarra de herramientas Advanced Animation (Animacién avanzada), seleccione la herramienta
Maintain Size (Mantener tamafio) 7.

» En el menu superior, seleccione Animation > Tools > Maintain Size (Animacion > Herramientas >
Mantener tamaiio).

» PulseAlt + 6.
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2. Enlavista lateral o superior, seleccione una de las capas de la seccién de imagenes en miniatura. También
puede seleccionar una capa en la vista de linea de tiempo.

La capa seleccionada se resalta en las vistas superior, lateral y de camara.

3. Arrastre la capa a la posicion de profundidad correcta en el cono de camara. El aspecto del elemento per-
manecera igual en la vista de camara.

4. Para aumentar o reducir la escala del elemento en relacion a su distancia de la camara, realice una de las
siguientes acciones:

» Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Transform (Transformar)
i"1. Asegurese de que esté desactivada la opcion Peg Selection Mode (Modo de seleccion de peg) /-

5
en la vista de propiedades de la herramienta.

» Enlabarra de herramientas Advanced Animation (Animacion avanzada), seleccione la herramienta
Translate (—I—) (Traslacion) y seleccione una capa en la seccion de imagenes en miniatura de la vista
superior o lateral.

» Seleccione una capa en la vista de linea de tiempo.

La capa seleccionada queda resaltada en el cono de camara.
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5. Enlavista superior, arrastre el elemento hacia los lados hasta su posicion en horizontal. Mantenga pul-
sada la tecla Mayus mientras arrastra el elemento para asegurarse de que solo se mueve a lo largo del eje

X.

6. Enlavista lateral, arrastre el elemento seleccionado hacia arriba o hacia abajo hasta su posicién en ver-
tical. Mantenga pulsada la tecla Mayus mientras arrastra el elemento para asegurarse de que solo se

mueve alolargo del eje Y.
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Capitulo 17: Importacién de sonido y sincronizacién
de labios

_ S L oy e
— = W

Si decide agregar sonido a la animacién, debe preparar primero el sonido fuera de Harmony. Después de ello, debe
agregar un elemento de sonido en Harmony para organizar los archivos de sonido en la animacion. El sonido se
reproducira en la pelicula hasta que llegue al final del archivo o a un fotograma de detencién que haya creado en el
editor de elementos de sonido.

Si primero crea el proyecto en Toon Boom Storyboard Pro, el sonido se dividira automaticamente en las distintas
escenas.

Puede importar archivos de sonido .wav, .aiff o .mp3.

Importacién de un archivo de sonido

1. Realice una de las siguientes acciones:

» En el menu superior, seleccione File > Import > Sound (Archivo > Importar > Sonido).

» Enlavista de carta de exposicion, haga clic con el boton derecho en cualquier parte del area de
fotogramas y seleccione Import > Sounds (Importar > Sonidos).

» En el menlt Xsheet (Carta de exposicién), seleccione File > Import > Sounds (Archivo > Importar >
Sonidos).

» En el mena Timeline (Linea de tiempo), seleccione Import > Sounds (Importar > Sonidos).
Se abre el cuadro de dialogo Select Sound File (Seleccionar archivo de sonido).

2. Enel cuadro de didlogo Select Sound File (Seleccionar archivo de sonido), busque y seleccione un archivo
de sonido.

El archivo de sonido aparece como una capa en las vistas de linea de tiempo y de carta de exposicion.

Distintas vistas del mismo archivo de
sonido

| Kalimba.mp3

89



Capitulo 17: Importacion de sonido y sincronizacion de labios

Sincronizacion de labios

Agregar una sincronizacién de labios a un proyecto mejora realmente su calidad y la narracién. Sin embargo, puede
ser dificil dar a un personaje la forma de boca adecuada al sonido en un fotograma concreto.

Para resolver este problema, Harmony ofrece una opcion de sincronizacion de labios, que analiza el contenido de
un elemento de sonido y genera una carta de fonemas (consulte a continuacion) en funcién de los ocho fonemas
de animacion (A, B, C, D, E, F, Gy X para silencio).

Las formas de boca que se utilizan en Harmony se basan en la carta de fonemas convencional utilizada en el
sector de la animacion.

NOTA: Las letras utilizadas para representar las formas NO corresponden con un sonido real.

~ \

A B C D
i’ S PN A
E F G X
(
Boca

Esta es una aproximacion del sonido que puede producir cada forma de la boca en inglés:

« Am,b,p,h

« B:s,d,j, ikt
+ Ciea

« D:AE

« Eo

* Fu

« G:f,ph

« X: silencio, sonido indeterminado

Puede sincronizar los labios del modo tradicional o dejar que el sistema cree automaticamente la deteccion
automética.

Puede consultar las posiciones de la carta de fonemas mientras dibuja la forma de la boca del personaje.

Deteccion automatica de sincronizacion de labios

Harmony puede asignar automaticamente dibujos en un elemento a la carta de fonemas generada para un sonido.
Puede ahorrar tiempo al sincronizar los labios una pista de voz.
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En la vista Layer Properties (Propiedades de capa), puede identificar cada dibujo de labios de un personaje.
Harmony etiqueta automaticamente todas las celdas del elemento de un personaje con el nombre adecuado.

Generacién de una deteccién de sonido para sincronizacién de labios mediante la vista de propiedades
de capa

1. Enlavista de linea de tiempo o de carta de exposicion, seleccione la capa de sonido.

Las opciones para dicha capa apareceran en la vista de propiedades de capa.

2. Enlas propiedades de capa, haga clic en Detect (Detectar).

Sound Editor

Aparece una barra de progreso mientras Harmony analiza los clips de sonido seleccionados y asigna una
letra de sincronizacion de labios a cada celda de sonido.

3. Haga clic en el boton Map (Asignar) para abrir el cuadro de dialogo Lip-Sync Mapping (Asignacion de sin-
cronizacion de labios).

Y]
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4.

o

En el menu Destination Layer (Capa de destino), seleccione la capa que contiene las posiciones de la
boca para la pista de voz del personaje.

Si la capa seleccionada contiene simbolos, puede asignar la sincronizacioén de labios utilizando dibujos
situados directamente en la capa o bien utilizar los fotogramas del simbolo. En el campo Symbol Layer
(Capa de simbolos), seleccione Don't Use Any Symbol (No usar ningun simbolo) si desea utilizar los dibu-
jos o el simbolo deseado del menu desplegable.

En la seccion Mapping (Asignacion), escriba el nombre del dibujo o los fotogramas del simbolo en el
campo situado a la derecha del fonema que representa. Si los dibujos ya tienen los nombres de las letras
del fonema, no es necesario hacer nada.

Haga clic en OK (Aceptar).

Pulse el boton Play (Reproducir) g en la barra de herramientas Playback (Reproducir) para very oir los

resultados en la vista de camara. Para reproducir la escena con sonido, active el botén Sound (Sonido)
o enla barra de herramientas Playback (Reproducir).
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Capitulo 18: Adicién de efectos a una escena

Una vez que la animacion esta finalizada, puede agregar efectos como desenfoques y brillos para que el proyecto
tenga un aspecto incluso mejor. Harmony proporciona diversos efectos basicos que puede agregar a las capas.

Acerca de los efectos

Un efecto siempre necesita una conexion de dibujo y, en ocasiones, un mate o conexion de forma. Un mate
proporciona informacion de dibujo que determina el area en la que el efecto se aplicara sobre el dibujo. Los detalles y
los colores dentro del dibujo de mate no son importantes, ya que solo se utilizan la forma y las transparencias. A un
mate también se le conoce como mascara.

El principio de mate se puede demostrar con el efecto de cuchilla.

S0k

El efecto de cuchilla permite cortar una parte de una imagen usando un dibujo de mate Puede utilizar el efecto de
cuchilla para permitir que un personaje desaparezca detras de un elemento de fondo o para cortar un orificio virtual
en la propia capa. La cuchilla requiere una entrada de mate.

Ajuste las propiedades de cuchilla para invertir el efecto del mate en una imagen. En lugar de que el objeto oculte la
mascara, solo se vera cuando cruce la zona de forma del mate.
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Puede ajustar los parametros del efecto en la vista de propiedades de capa y vincular cualquiera de ellos a una
columna de funcion que se animara a lo largo del tiempo. Esto implica que todos los efectos se pueden
personalizar.

Adicién de efectos

Efecto de cuchilla

El efecto de cuchilla permite cortar una parte de una imagen usando un dibujo de mate Puede utilizar el efecto de
cuchilla para permitir que un personaje desaparezca detras de un elemento de fondo o para cortar un orificio
virtual en la propia capa. La cuchilla requiere una entrada de mate.

Ajuste las propiedades de cuchilla para invertir el efecto del mate en una imagen. En lugar de que el objeto oculte
la méscara, solo se vera cuando cruce la zona de forma del mate.

Uso del efecto de cuchilla

1. Enlavista de dibujo o de cdmara, cree un dibujo en una nueva capa que actuara como mate.

2. Enlavista de linea de tiempo, haga clic en el botén Collapse/Expand (Contraer/expandir) de la capa
del efecto.
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3. Visualice las propiedades de la cuchilla.

Layer Properties @

Propiedades de Cuchilla

Parametro Descripcién

Name (Nombre) Permite cambiar el nombre del nodo.

Cuando se habilita esta opcion, el nodo de cuchilla invertira la forma del mate
Inverted (Invertido) para cortar el dibujo. En lugar de cortar laimagen cruzandola con el mate, cortara
la parte de la ilustracion que quede fuera de la forma del mate.

Animacion de un efecto a lo largo del tiempo

Al componer la escena, con frecuencia deseara animar los parametros de un efecto a lo largo del tiempo. Por
ejemplo, puede realizar un fundido de entrada o de salida en un objeto cambiando el nivel de transparencia con el
tiempo o aumentando el contraste de color en uno de los dibujos en un rango de fotogramas determinado.

Para animar un efecto a lo largo del tiempo, cree una curva de funcién agregando fotogramas clave a los parametros
gue desee animar. Para ello, utilizara las vistas de propiedades de capay linea de tiempo. Puede ajustar la
animacion utilizando la vista de funcion.

Animacién de un efecto a lo largo del tiempo

1. Creela curva de funcion realizando una de las siguientes acciones:

» Haga doble clic en la capa de efecto para mostrar las propiedades del mismo. Haga clic en el boton
Function (Funcion) s° del parametro que desee animary cree una curva de funcion.
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» Enlavista de linea de tiempo, expanda los parametros de la capa del efecto haciendo clic en el botén
Collapse/Expand (Contraer/expandir) . A continuacién, haga clic en el botén Function (Funcion)
r* del parametro que desee animar y cree una curva de funcion.

2. Enlavista de linea de tiempo, vaya al fotograma en el que desea comenzar a animar el efecto.

3. Enlabarra de herramientas Timeline (Linea de tiempo), haga clic en el botén Add Keyframe (Agregar foto-
gramaclave) % .

4. Enelcampo Value (Valor) del parametro que desee animar, introduzca el valor del fotograma clave. Si los
fotogramas clave son fotogramas clave de Stop-motion, en la vista de linea de tiempo, seleccione los nue-
vos fotogramas clave. Haga clic con el botdn derecho y seleccione Set Motion Keyframe (Definir foto-
grama clave de movimiento).

5. Repita este proceso para cada fotograma clave que se vaya a agregar.
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Capitulo 19: Exportaciéon de una pelicula

Si necesita un archivo de video, puede exportar la animacién como una pelicula de QuickTime. Para renderizar una
pelicula de QuickTime con transparencia, debe establecer la profundidad en Millions of Colours + (Millones de
colores +). Puede establecer esta opcion al exportar una pelicula de QuickTime.

Si el video exportado es demasiado pequefio o demasiado grande, puede cambiar el tamafo del proyecto desde el
menu superior en Scene > Scene Settings (Escena > Configuracion de escena). Cambiara el tamafio de la salida
de video.

Exportacién de una pelicula de QuickTime

1. En el menu superior, seleccione File > Export > Movie (Archivo > Exportar > Pelicula).

Se abre el cuadro de didlogo Export to QuickTime Movie (Exportar a pelicula de QuickTime).

2. Haga clic en Browse (Examinar), seleccione una carpeta en la cual guardar la pelicula y asignele un nombre
de archivo para la exportacion.

3. Hagaclic en OK (Aceptar).

1. Enlaseccioén Display Source (Mostrar original), seleccione el nodo de visualizacion que desea utilizar para
renderizar el proyecto.

2. Enlaseccioén Export Range (Rango de exportacion), decida si desea exportar toda la escena (All (Todo)) o un
intervalo de fotogramas especifico. Si decide lo ultimo, introduzca un rango de fotogramas.

3. Enlaseccion Resolution (Resolucién), seleccione una de las siguientes opciones en el menu:

» Unarelacion de resolucion preferida.

» Custom (Personalizado): activa los campos Width (Anchura) y Height (Altura) para que pueda introducir
un tamano especifico.

4. Enla seccion Options (Opciones), haga clic en Movie Options (Opciones de pelicula).
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Movie Settings

V| Video
Settings... Compression: Animation
Depth: Millions of Colors
Quality: Best
\L’ Frame rate: 24
———— |Keyframe rate: 48
Size...

Allow Transcoding

| Sound
Settings... Format: Uncompressed
Sample rate: 22.05 kHz

Sample size: 16
Channels: 1

/| Prepare for Intemet Streaming

Fast Start - Settings

Cancel

Parametro Descripcién

Permite la personalizacion de la configuracion, los filtros y el
tamario de video.

Settings (Configuracion): Abre el cuadro de dialogo Standard
Video Compression Settings (Configuracion de compresion de
video estandar).

Video (Video) Filter (Filtro): Abre el cuadro de diadlogo Choose Video Filter
(Elegir filtro de video), en el que puede seleccionar distintos
filtros para aplicarlos a la exportacion de video.

Size (Tamano): Abre el cuadro de didlogo Export Size Settings
(Exportar configuracion de tamafio). La configuracion de tamafio
se sobrescribe con la configuraciéon de escena de Harmony.

Permite la personalizacion de los ajustes de sonido.

Sound (Sonido) Settings (Configuracion): abre el cuadro de didlogo Sound
Settings (Ajustes de sonido) (ver a continuacion).

Prepare for Internet Streaming
(Preparar para streaming de
Internet)

Permite la personalizacion de las opciones de streaming de
Internet.

5. Enlaseccion Video (Video), haga clic en Settings (Configuracion).

Se abre el cuadro de dialogo Standard Video Compression Settings (Configuracion de compresion de
video estandar).
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10.

11.

Standard Video Compression Settings

Compression Type:  Animation -
Motion Data Rate
Frame Rate: 24 - fps Data Rate: (@) Automatic
Restrict to kbits/sec
Key Frames: () Automatic
@ Every 43 frames Optimized for: | Download
Al
Frame Reordering
Compressor Preview
Depth:  Millions of Colors -
Quality
L:aast Lcluw Meélium Hilgh Best
B -

En el menu Compression Type, seleccione un codec. La disponibilidad de una configuracion de compresién
determinada depende del tipo de compresién seleccionado. Por ejemplo, Animation (Animacion) es el tipo de
compresion predeterminado y, por lo tanto, la opcion Data Rate (Ratio de datos) esta atenuada.

En la seccion Motion (Movimiento), seleccione un valor de Frame Rate (Fotogramas por segundo) de la
lista.

Esta establecida de forma predeterminada para coincidir con los fotogramas por segundo (fps) del proyecto
de Harmony. Si selecciona un nimero de fotogramas por segundo inferior, la reproduccion de exportacion
sera mas rapida que el proyecto real. Lo contrario también es cierto para un nimero de fotogramas por
segundo superior.

Si desea insertar fotogramas clave, seleccione la opcion Every (Cada) y establezca el nimero por foto-
grama.

Esta es la opcién recomendada por QuickTime. Para obtener mas informacion, consulte la documentacion
de QuickTime.

En la seccion Quality (Calidad), utilice el control deslizante para seleccionar una configuracion de calidad.
Recuerda que cuanto mejor es la calidad de la exportacion, mayor es el archivo.

Quality

Least Low Meélium Hilgh
- >

En la seccion Data Rate (Ratio de datos), seleccione permitir que el programa seleccione automaticamente
la tasa de bits 6ptima, o bien introduzca un ratio restrictivo para ahorrar espacio y permitir una descarga mas
rapida sacrificando calidad de exportacion.

En la misma seccion, en el menu Optimized For (Optimizado para), seleccione el método de visualizacién
previsto para la exportacion.
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12.

13.

14.

15.

16.

17.

18.

19.

Haga clic en OK (Aceptar).

Desde el cuadro de dialogo Movie Settings (Configuracion de pelicula), haga clic en Sound Settings (Con-
figuracion de sonido).

Se abre el cuadro de dialogo Sound Settings (Configuracién de sonido).

Sound Settings

Compressor: Mone hd

Rate: 22,050 kHz [
Size: 8 bit @ 16 bit

Use: @ Mono Stereo

Options Cancel

En el menu Compressor (Compresor), seleccione un tipo de compresion. La configuracion predeterminada
es None (Ninguno). De este modo se conservara el archivo de sonido original sin perder informacién. Sin
embargo, un archivo de sonido no comprimido agregara inevitablemente “peso” al tamanio total de la expor-
tacion de video.

En el menu Rate (Ratio), seleccione un ratio. Es mejor que compruebe y haga coincidir las propiedades ori-
ginales del archivo de sonido. Por ejemplo, si el archivo tiene una tasa de muestreo de sonido de 48 kHz y
elige una tasa de conversion de 22,05 kHz, el sonido se reproducira a la misma velocidad, pero faltaran las
frecuencias mas altas. Para una calidad de sonido de pelicula estandar, seleccione 44.1 kHz 0 48 kHz
para la calidad de DVD. Un valor inferior hara que el sonido sea “sordo” o tenga menos brillo. Para ele-
mentos como voz grabada no importa demasiado, pero para la musica puede suponer una diferencia detec-
table. Si es necesario tener en cuenta el tamano del archivo, como en los videos para Internet, podria ser
practico utilizar una tasa inferior.

Seleccione Size (Tamafio) y Use (Usar), que estan relacionados. Se recomienda comprobar las pro-
piedades del archivo de sonido original. Si el archivo se grabd en un canal (mono), no tiene sentido selec-
cionar la opcion de dos canales (estéreo). Aunque el modo puede admitir un canal de 16 bits, la
informacion adicional no es necesaria. Mono esta normalmente emparejado con 8 bits y estéreo con

16 bits.

Haga clic en OK (Aceptar).

En el cuadro de didlogo Export to Quick Time Movie (Exportar a pelicula de QuickTime), haga clic en OK
(Aceptar).

Aparece una barra de progreso.

Desplacese a la ubicacion en el ordenador en la que ha guardado el video de QuickTime y haga doble clic
en ella para ver la exportacion.

Configuracién de la profundidad en Millions of Colours + (Millones de colores +) para exportar una
pelicula de QuickTime con transparencia

»

En el cuadro de didlogo Standard Video Compression Settings (Configuracién de compresion de video
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Compression Type:  Animation
— Mation

Frame Rate: 24

- fps
Key Frames: (=) Automatic

@ Every

48 frames
DAl

Frame Reordering

Depth:

Millions of Colors
Quality |

Black and White
4 Grays
| e—

4 Colors =
Low | 16 Grays

16 Colors
| 256 Grays

256 Colors

Thousands of Colors
Millions of Colors

Millions of Colors+
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Glosario

3D stereoscopic
(3D
estereoscépico)

Capacidad de crear imagenes estéreo que, cuando se animan y se ven a través de gafas
con obturador activo 3D o mediante gafas con una lente roja y otra azul, se mostraran como
una pelicula tridimensional.

alpha channel

Canal de imagen que contiene informacion de transparencia. De partida, una imagen tiene

(canal alfa) tres canales: rojo, verde y azul (RGB). El canal alfa es el cuarto canal (A). El mate, o
informacion de transparencia, se almacena en este cuarto canal. Una imagen sin canal alfa
siempre es opaca.

animatic Pelicula con sonido que se desarrolla a partir del storyboard. El panel de storyboard queda

(animatica)

expuesto durante el transcurso de la escenay, en ocasiones, los personajes se colocan en
una trayectoria para indicar movimiento. Los movimientos de camara también estan
animados. La animatica se utiliza para determinar el ritmo de un proyecto y proporciona una
buena visién general del proyecto antes de comenzar la produccién.

animation
(animacién)

Simulacion de movimiento creada mostrando una serie de imagenes o fotogramas.

anime

Estilo de animacién conocido por su aspecto siniestro y oscuro, popular en Japon.

arc (arco)

La accién no suele producirse de forma directa, sino que mas bien se suele desplegar en lo
que los narradores denominan un arco. El propdsito de un arco de historia es mover un
personaje o situacion de un estado o escenario al siguiente.

aspect ratio
(proporcion)

Relacién entre las dimensiones de anchura y altura de una escena, fotograma o formato de
pelicula. La proporcion en television es de 4:3 y la proporcién panoramica de 16:9.

auto-feed
(alimentador de
papel automatico)

Método automatizado de introducir dibujos en un escaner en el que hay varios dibujos
apilados en un alimentador de hojas. Cuando se activa el escaner, los dibujos se digitalizan
de forma consecutiva, sin ninguna otra intervencion del usuario.

automatic lip-sync
detection
(deteccién
automatica de
sincronizacién de
labios)

Asignacién automatica de dibujos en un elemento a la carta de fonemas generada para un
sonido. Puede ahorrar tiempo al sincronizar los labios una pista de voz.

axis (eje)

Linea imaginaria alrededor de la cual rota un objeto.
Para graficos 2D, hay dos ejes: X (horizontal) e Y (vertical).
Para gréficos 3D, hay tres ejes: X (horizontal), Y (vertical) y Z (profundidad).

En animaciones que rotan constantemente, el elemento de eje especifica alrededor de qué
eje rota el objeto. Un nimero negativo provoca que una animacion gire en sentido contrario
a las agujas del reloj, mientras que un nimero positivo hace que una animacion gire a la
derecha.

background
(fondo)

Parte de una escena que esta mas alejada hacia la parte posterior. El fondo es la
ilustracion, o decoracion, sobre la que se produce la animacion.

Bézier (curva
Bézier)

Método para definir lineas curvas inventado por el matematico francés Pierre Bézier. Una
curva Bézier es una curva matematica o paramétrica. Las curvas Bézier utilizan al menos
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tres puntos para definir una curva.

bitmap (mapa de
bits)

Imagen compuesta por pixeles con una unica resolucion (tamafo). Si se amplia demasiado,
perdera definicion y comenzaran a aparecer pixeles individuales. A esto se le conoce como
pixelacion.

Los archivos de imagen de mapa de bits se definen como una malla rectangular estdndar de
pixeles individuales. Cada pixel individual contiene un valor que representa un color
especifico.

breakdown
(descomposicién)

En animacion Cut-out, la descomposicién es la accion de descomponer un personaje en
trozos para crear una marioneta con articulaciones. Para descomponer un personaje, el
artista corta partes, como las manos y los brazos, del modelo del personaje y las pega en
capas independientes. A continuacion, las articulaciones se fijan y se definen los pivotes.

En la animacioén tradicional, una descomposicién es una pose de animacion que
normalmente se encuentra entre dos poses clave. Las poses clave son las poses
principales de una animacién y las descomposiciones son poses secundarias que ayudan a
describir el movimiento y la curva de rotacién (normalmente denominada arco).

camera shake
(vibracion de
camara)

La vibracién de cdmara se produce en una escena cuando la cdmara se mueve ligeramente
y rapidamente en varias direcciones. Este movimiento da la impresién de impacto,
vibracion o, por ejemplo, baches en la carretera.

caption (cuadro

Campo de texto que contiene informacion de dialogo, efectos, sonido o slugging en un

de texto) storyboard.
cel (celda) En la animacion tradicional, una celda (también denominada celuloide) es una hoja
transparente en la que la animacion se tinta y se pinta antes de enviarla a la camara. El
trazado de la imagen se dibuja en la parte delantera de la celda y, a continuacién, se colorea
por la parte trasera.
character design | Cada personaje de una pelicula animada se dibuja desde varios angulos en formato de
(diseiio del estilo poster denominado hoja de modelo, que sirve como referencia para los animadores.
personaje)
chromatic En dptica, una aberracion cromatica (CA), acromatismo o distorsion cromatica, es un tipo
aberration de distorsion en el que una lente no puede enfocar todos los colores en el mismo punto de
(aberracién convergencia.
cromatica)
clean up Una vez que los bocetos se han evaluado y aprobado, se quita todo el ruido de la imagen
(lineas sobrantes, notas, etc.) para crear dibujos finales que se pueden tintar, pintary filmar.
El proceso de clean up hace referencia al trazado de una linea limpia sobre un boceto para
conseguir la version final o a la eliminacion de la suciedad y las lineas adicionales que han
quedado tras el proceso de digitalizacion.
CMYK Acrénimo en inglés de cian, magenta, amarillo y negro. Estos colores forman el modelo

estandar utilizado en un proceso denominado impresion offset.

colour card (carta
de color)

Una carta de color es una tarjeta que contiene un color sélido con el mismo tamario que la
camara. La carta de color rellena el fondo con un color sélido cuando no se ha incluido
ninguna imagen de fondo.

colour model
(modelo de color)

Disefio de color oficial que se debe utilizar para pintar la animacién. Un modelo es el disefio
de personaje, prop o ubicacion definitivo que cada artista debe seguir para la produccion.

colour wheel

Visualizacion del espectro de colores en forma de circulo.
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compositing
(composicién)

La composicién es la accion de incorporar todos los elementos de una escena para crear el
resultado final antes del renderizado. Por ejemplo, el artista de la composicién importara
todas las secuencias, el fondo, las superposiciones y las subcapas de la animacioén en la
escenay los colocara correctamente. A continuacion, el artista definira el encuadre de
camaray lo animara en caso necesario. Por ultimo, el animador creara todos los efectos
generados por ordenador para el proyecto.

cross dissolve
(fundido
encadenado)

Efecto utilizado para fundir dos escenas, una dentro de la otra.

cut (corte)

Transicion directa entre dos escenas. Cuando se utiliza un corte, no se insertan efectos de
transicion para pasar de una escena a la siguiente. La primera escena termina y la segunda
comienza inmediatamente.

cut-out a nimation
(animacién Cut-
out)

El proceso conocido como animacion Cut-out es la accion de animar personajes
compuestos por varias piezas moviéndolos de fotograma en fotograma. La animacion Cut-
out se puede generar por ordenador o realizarse del modo tradicional utilizando papel.

cycle (ciclo)

Grupo de imagenes que forman juntas una accién, como caminar. Un ciclo es una accion
repetida como un bucle durante un periodo de tiempo. Puede ser una serie de dibujos o
fotogramas clave animados.

dialogue (diadlogo)

Texto hablado por un personaje en una pelicula o animacion.

dope sheet (carta
de rodaje)

La utilizan los animadores, directores y otros miembros del equipo para trazar la secuencia
y el tiempo de las imagenes, el dialogo, los efectos de sonido, las pistas de sonidoy los
movimientos de camara. Conocida también como carta de exposicion.

doping (usar carta
de rodaje)

Asignar un dibujo determinado a un rango de fotogramas.

double bounce
walk (paso con

En los fotogramas clave y las posiciones de paso de un paso con doble bote, el cuerpo es
menor que una linea de referencia dibujada en posicion vertical. Durante los intercalados, el

doble bote) cuerpo esta situado sobre esta linea, ofreciendo asi un aspecto de rebote.

DPI Siglas en inglés para puntos por pulgada, que representa la medida estandar de resolucion
para impresoras computerizadas. En ocasiones se aplica a pantallas, en cuyo caso es mas
exacto denominarlo pixeles por pulgada. En cualquier caso, el punto es el elemento discreto
mas pequefio que forma la imagen.

ease En animacion, la velocidad es la aceleracion y la deceleracion de un movimiento. Puede ser

(aceleracién)

un movimiento creado mediante una curva de funcién o una serie de dibujos animados.
Otros términos comunes para aceleracion-gradual y desaceleracion-gradual son
aceleracién y desaceleracion.

ease-in
(aceleracién-
gradual)

Aceleracion gradual en la accion. Conocida también como aceleracion.

ease-out
(desaceleracién-
gradual)

Desaceleracién gradual en la accion. Conocida también como desaceleracion.

establishing shot
(plano de

Escena en la cual el espectador puede ver toda el area en la que se esta produciendo una
secuencia. Por ejemplo, si un nifio esta jugando en el patio delantero de su casa, el plano de
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situacién seria una escena en la que el visor puede ver la casa, el patio, parte de la calle y
los edificios situados alrededor del punto de accién central. Esto ayuda al espectador a
entender la ubicacién de la historia y la orientacién de la escena.

exposure En animacion, una exposicion es el nimero de celdas en las que un dibujo aparece en la
(exposicion) escena. Para que un dibujo parezca mas grande, la exposicion se debe ampliar durante un
numero de celdas mayor.

exposure sheet | Hoja con varias columnas verticales y fotogramas horizontales que se utiliza para indicar el
(carta de tiempo de una escena. Cada columna representa una capa de escena. Los numeros de
exposicion) dibujos de cada columna se indican y se repiten a lo largo de la cantidad de fotogramas
determinada en la que deben aparecer.

La carta de exposicion la utilizan los animadores, directores y otros miembros del equipo
para trazar la secuencia y el tiempo de las imagenes, el dialogo, los efectos de sonido, las
pistas de sonido y los movimientos de camara. Conocida también como carta de rodaje.

fade in/fade out El fundido de entrada o fundido de salida es un efecto de transicion utilizado para abrir o

(fundido de cerrar una secuencia. Un fundido de entrada se produce cuando la primera escena aparece
entrada/fundido de| progresivamente, desde una transparencia total a su opacidad total. Un fundido de salida se
salida) produce cuando la escena desaparece progresivamente, desde la opacidad total a la

transparencia total.

fast-in Aceleracion drastica al principio de la accién.
(aceleracién de
entrada)

fast-out Aceleracion drastica al final de la accion.
(aceleracion de
salida)

field (campo) Unidad de medida utilizada para calcular el movimiento, el registro y la posicion de la
camara. Una escena de animacion estandar tendra entre 6 y 12 campos.

field chart (hoja Guia que contiene todas las unidades de campo que los artistas de animacion y layout uti-
de campos) lizan para determinar un tamafio de escena o movimiento de camara.

film-1.33 Resolucién idonea para el formato de pelicula panoramico que se ajusta a la proporcion
estandar de 4:3 pixeles.

film-1.66 Resolucién idénea para el formato de pelicula panoramico que se ajusta a la proporcion de
16:9 pixeles. (Los pixeles son mas anchos que altos).

flipping En la animacioén tradicional, flipping es la accidn de pasar por los dibujos de una secuencia
de animacion muy rapidamente con el fin de ver la animacion en movimiento. Flipping
también puede ser la accion de crear una transicién menor de un objeto.

follow-through Movimiento secundario provocado por la accion principal. Por ejemplo, un personaje que
(animacién corre y lleva puesta una capa. La accion principal es el cuerpo que corre. Esto provocara
secundaria) que la capa siga el movimiento, aunque no se movera al mismo tiempo, sino que

reaccionara varios fotogramas después y seguira la curva de movimiento principal.

forward La cinematica directa es una funcién utilizada para animar principalmente personajes 3D y
kinematics marionetas Cut-out con jerarquia. Se utiliza para animar una marioneta a partir de una de
(cinematica sus partes principales, como un hombro, y hacer que el resto del brazo se mueva con ella
directa) como un todo.
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frame (fotograma)

Un fotograma de animacién es una imagen fotografica Unica en una pelicula. Enla
animacion tradicional, el estandar norteamericano contiene generalmente 24 fotogramas por
segundo, mientras que el estandar europeo es de 25.

frame rate
(fotogramas por
segundo)

Los fotogramas por segundo son la velocidad a la que se reproducen los fotogramas. Se
calcula por lo general en fotogramas por segundo. Por ejemplo, una escena se podria
reproducira 12, 24, 25, 30 o 60 fotogramas por segundo o a cualquier otro numero.

Es la medida de la frecuencia (ratio) a la que un dispositivo de imagen produce imagenes
consecutivas unicas, denominadas fotogramas. El término se aplica por igual a los graficos
por ordenador, videocamaras, camaras de pelicula y sistemas de captura de movimiento.

La velocidad de fotogramas se suele expresar principalmente en fotogramas por segundo
(fps) y en monitores de barrido progresivo en hercios (Hz).

function (funcion)

Movimiento, trayectoria o ruta generados por ordenador al que se pueden conectar
parametros de elementos, otras trayectorias y efectos. La funcion se puede controlar
agregando fotogramas clave y puntos de control en la curva de funcion.

gamut (gama) Rango de colores que puede representar un dispositivo determinado.

HDTV Acrénimo en inglés de television de alta definicidon que ofrece una imagen de mayor calidad
que la television estandar, ya que dispone de un numero de lineas de resolucion superior.
Para sacar partido de la calidad superior y utilizar plenamente la configuracién de
resolucion, el dispositivo de salida debe ser compatible con la tecnologia HDTV.

hold Fotograma en la animacion en el cual el personaje mantiene su posicion sin moverse. Se
puede crear un hold entre dos fotogramas clave cualesquiera.

HSV Siglas en inglés para matiz, saturacién y valor. Método para definir los colores en cuanto a
matiz (tinte), saturacién (sombra) y valor (tono o luminancia).

in-between Dibujos que existen entre las poses clave. Se dibujan para crear transiciones fluidas entre

(intercalado)

poses.

ink and paint

El proceso ink and paint es la accién de pintar las zonas vacias y colorear las lineas en los
dibujos de animacion finales siguiendo un modelo de color.

interpolation
(interpolacién)

Movimiento generado por ordenador creado entre dos fotogramas clave. Se puede crear
interpolacion, o no, entre los fotogramas clave.

inverse kinematics
(IK) [cinematica
inversa (IK)]

Funcion utilizada principalmente para animar personajes 3D y marionetas Cut-out con
jerarquia. La cinematica inversa animara una marioneta desde una de las extremidades,
COmo una mano, y permitira que el resto del cuerpo la siga con naturalidad.

jump cut (corte de
salto)

Corte brusco entre dos escenas. Normalmente, un corte de salto no es visualmente
agradable. Normalmente lo provoca el final de una escena y el comienzo de otra, con una
imagen parecida. La falta de diferencia provoca que el ojo vea un pequefio salto entre las
dos escenas.

key pose (pose
clave)

Posiciones importantes en la accion que definen los puntos inicial y final de cualquier
transicion suave. Las claves, o poses clave, son los dibujos principales de una secuencia
de animacion que describen el movimiento. Por ejemplo, si se agita un brazo, las claves
corresponderan al brazo de una extremidad del movimiento de onda y a la otra extremidad.
Al realizar un flipping de dichos dibujos, el animador puede ver el esqueleto del movimiento
sin tener todos los dibujos.

keyboard

Una o varias teclas del teclado que, al usarlas, provocan que se realice una operacion.

107




Glosario

shortcut s (atajos
de teclado)

keyframe
(fotograma clave)

Posiciones importantes en la accion que definen los puntos inicial y final de cualquier
accioén. Un fotograma clave es una posicion generada por ordenador en un momento
especifico (fotograma) y en una trayectoria determinada.

layer (capa)

En animacion, una capa es una columna, nivel o personaje individual. Las capas de una
escena estan superpuestas para formar la imagen final.

layout

Paso de comunicacion entre el storyboard y la animacion. Es la accién de poner el
storyboard en el modelo. Es decir, el personaje se dibuja siguiendo el disefio del paquete de
modelo, de modo que el animador puede comenzar a trabajar.

El artista de layout dibuja el fondo y crea la camara y la guia de campo, haciendo coincidir la
escenay el movimiento de la camara. Por ultimo, el animador dibuja en el modelo las poses
de accidn principales.

layout and posing
(layouty pose)

Accion que consiste en poner el storyboard en el modelo (a la escala adecuada) para que el
animador comience a trabajar.

layout artist (artista
de layout)

Artista que dibuja el fondo y crea la camara y la guia de campo, haciendo coincidir la escena
y el movimiento de la camara. Dibujara en el modelo las poses de accion principales.

layout planning
(planificaciéon de
layout)

Dibujo de las funciones principales de la escena que se utiliza como referencia al planificar
la animacion y ejecutar sus etapas iniciales.

layout process
(proceso de
layout)

Paso de comunicacion entre el storyboard y la animacion.

library (libreria)

Zona de almacenamiento que contiene plantillas y recursos que se pueden reutilizar en un
proyecto o escena.

light table (mesa
de luz)

Dispositivo que permite ver otras capas en transparencia mientras trabaja en una capa
determinada.

line of action
(linea de accion)

Direccién que seguira la accion. Conocida también como linea de accion.

lip-sync
(sincronizacién de
labios)

Proceso de sincronizar la boca de un personaje en sonidos en la pista de sonido del dialogo.
La boca se ajusta fotograma a fotograma para hacer coincidir el sonido del didlogoy
aparentar que el personaje esta hablando. La sincronizacion de labios se puede utilizar para
cualquier secuencia de sonido y no solo para el habla. Por ejemplo, puede hacer que un
pajaro pie o que un lobo allle a la luna.

low resolution
(baja resolucién)

Formato idéneo para videos destinados a la web, donde el tamano y la descarga rapida del
archivo de video tienen prioridad respecto a la calidad. Una imagen de baja resolucion es
aquella que no contiene detalles precisos.

manual lip-sync
detection
(deteccion manual
de sincronizacién
de labios)

Intercambio manual de dibujos de posicion de la boca para que coincidan con una pista de
voz. Para este proceso, se utilizan tanto la depuracion de sonido (escuchar una onda de
sonido descompuesta fotograma a fotograma) como las sustituciones de dibujos.

master palett

Grupo de colores atribuidos a un personaje o prop. La paleta se utiliza durante toda la
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(paleta maestra)

produccion para mantener la coherencia en el aspecto y para garantizar que se utilicen los
mismos colores durante la produccién. Conocida también como paleta.

model/colour

Disefio de personaje, prop o ubicacion definitivo que cada artista debe seguir para una

model produccion. Un modelo de color es el disefio de color oficial que se debe utilizar para pintar
(modelo/modelo la animacion.

de color)

morphing Funcién que permite crear dibujos generados por ordenador entre un dibujo de origen y otro

de destino. La animacidn creada con la funcidon de morphing se puede reutilizar en distintos
proyectos.

motion keyframe
(fotograma clave
de movimiento)

Fotograma clave con interpolacion generada por ordenador.

mouth chart
(carta de fonemas)

Carta basada en los ocho fonemas de la animacion (A, B, C, D, E, F, Gy X, que se utiliza
para representar el silencio) utilizados para la sincronizacién de labios.

multiplane Efecto de pasar por diversos niveles de dibujos para crear una sensacion de profundidad en
(multiplano) un plano. Un multiplano es una escena en la que las capas estan colocadas a distintas
distancias de la camara, de modo que, cuando la camara se mueve, se produce una ilusion
de profundidad. Con un multiplano, toda la perspectivay la escala se calculan
automaticamente.

NTSC Sistema de difusion televisiva analogico estandar utilizado en Norteamérica. NTSC se cifie
a los estandares norteamericanos respecto al modo en que los pixeles rectangulares se
muestran para las pantallas de ordenador y de television.

nudge Pequefio empujon (izquierda, derecha, arriba, abajo, hacia delante o hacia atras) realizado

(desplazamiento | con las teclas de flecha del teclado en un elemento seleccionado. El desplazamiento
pequefio) pequefio se utiliza para mover una seleccion de manera muy ligera y precisa.

onion skin (papel
cebolla)

Funcién que permite ver los dibujos anterior y siguiente de una secuencia.

overlay Parte del entorno de una escena, como una silla o un arbusto, que se coloca delante de la
(superposicioén) animacion principal.
PAL Resolucién que funciona mejor con el formato europeo para pantallas de television y de

ordenador, ya que los pixeles rectangulares se muestran con una orientacion distinta.

palette/master
palette
(paleta/paleta
maestra)

Una paleta o paleta maestra es un grupo de colores atribuidos a un personaje o prop. La
paleta se utiliza durante todo el proyecto para mantener la coherencia en el aspecto y para
evitar cambios de color durante la animacion. También se le denomina paleta maestra.

palette style
(estilo de paleta)

Un estilo de paleta es una segunda versién de una paleta existente con un ligero cambio en
el tinte y el valor. Un estilo de paleta se puede utilizar para crear la versién nocturna de una
paleta. También se le puede denominar paleta de clonado.

pan (panear)

Mover la camara atravesando la escena en cualquier direccion.

panel En un storyboard, un panel es un fotograma en un plano. Un plano puede estar compuesto
por uno o varios paneles.
paperless El proceso de animacion sin papel es la accion de animar digitalmente. El principal proceso

animation/tradigital

de animacion sin papel es dibujar la animacion, fotograma a fotograma, directamente en el
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(animacién sin
papel/tradigital)

software.

passing position
(posicion de paso)

Al dibujar una secuencia en la que un personaje camina, la posicion de paso es el punto en
el que una pierna pasa a la otra.

path of action
(linea de accién)

Direccién que seguira la accién. Conocida también como linea de accion.

peg En la animacioén tradicional, es una herramienta utilizada para garantizar el registro preciso
de la accién a medida que se mueven las capas de celdas. En la animacion digital, en la que
se realiza un rigging de marionetas mas avanzado, se pueden usar capas de pegs. Las
capas de pegs son capas de trayectoria que no contienen dibujos. Son rutas de movimiento
que puede usar para agregar articulaciones de ruta. Para las ultimas, también puede utilizar
una herramienta de cinematica inversa.

phoneme Unidad de sonido de un idioma.

(fonema)
pivot (pivote) Punto alrededor del cual un peg o dibujo rota.
pixel (pixel) Elemento mas pequefio de una imagen mostrado en un monitor o pantalla de television.

El pixel, abreviatura en inglés de elemento de imagen, es un punto Unico en una imagen
grafica. Es una pequefia muestra de una imagen, un punto, un cuadrado o una seccion muy
pequeia compuesta de filtrado suavizado. Si acerca el zoom lo suficiente en una imagen
digital, vera los pixeles, que parecen pequefios cuadrados de distintos colores e intensidad.

pose-to-pose
animation
(animacién pose a
pose)

El proceso de animacioén pose a pose es la accidon que consiste en crear todas las poses de
accion principales, denominadas poses clave, y después colocar las poses secundarias
entre las claves. Las poses secundarias se denominan descomposicion. Por ultimo, el
animador rellena los huecos con los dibujos intercalados para lograr una animacion fluida.

rendering Paso final de la animacién por ordenador. Durante el renderizado, el ordenador toma cada
(renderizado) pixel que aparece en la pantalla y procesa todos los componentes. Ademas, agrega
desenfoque de movimiento antes de que produzca una imagen final. Es el proceso de
calcular las imagenes finales después del proceso de composicion.
resolution Tamafio de una escena, calculado por lo general en pixeles. Por ejemplo, la resolucion

(resolucién)

NTSC es de 720 x 480. La resolucion debe coincidir con la salida final: HDTV, film-1.33,
film-1.66, NTSC, PAL, baja.

RGB Siglas en inglés para rojo, verde y azul. Método que permite definir el color especificando
las cantidades de estos tres componentes del color.
rigging Proceso de conectar las distintas partes de una marioneta Cut-out.

rotary table (mesa
de disco)

Equivalente al disco/mesa de animacion, es un dispositivo que permite rotar el espacio de
trabajo para mayor comodidad mientras se dibuja.

rotoscoping
(rotoscopia)

Técnica de animacion en la que los animadores trazan un movimiento de pelicula de accién
en vivo, fotograma a fotograma, para usarlo en peliculas animadas. Es el acto de esbozar
sobre imagenes de accion en vivo para crear una secuencia animada.

roughs (bocetos)

Es un nombre comun en una pelicula de animacién para un dibujo que se utiliza como
referencia, pero no forma parte de la imagen final. Un layout es un boceto.

Es el esbozo del esqueleto de una animacion o disefio. Los bocetos consisten
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principalmente en lineas y formas esbozadas, pero también pueden contener detalles de
disefio.

safe area (zona
segura)

Zona central del fotograma de una escena que no quedara recortada por el fotograma de TV.
Como un fotograma de TV corta un margen del tamafo del fotograma original, al mantener
una zona segura se garantiza que la accion principal de la escena siga siendo claramente
visible una vez que la pelicula se proyecte en television.

scene (escena)

Plano en una pelicula o programa. Una secuencia estd compuesta por varias escenas. Una
escena cambia a otra mediante un corte simple o por transicion.

script (guion)

Texto original que contiene la informacién de toda la pelicula o el programa. En animacion,
el guion contiene todas las descripciones de la ubicacion, el didlogo, el tiempo, etc. Un
proyecto comienza con un guion.

sequence
(secuencia)

Serie de escenas o planos que forman una parte distinta de la historia o pelicula,
normalmente conectadas por la unién de la ubicacion o el tiempo.

shot (plano) Escena en una pelicula o programa. Una secuencia esta compuesta por varios planos. Un
plano cambia a otro mediante un corte simple o por transicion.
slow-in Aceleracion gradual en la accion. Conocida también como aceleracion-gradual.

(aceleracion)

slow-out
(desaceleracién)

Desaceleracién gradual en la accion. Conocida también como desaceleracion-gradual.

slugging

Indicacién de los tiempos de inicio y detencion de un didlogo y las acciones relevantes.

sound scrubbing
(depuracién de
sonido)

Proceso que permite escuchar el sonido en tiempo real, mientras mueve el cabezal de
reproduccion hacia delante o hacia atras. Es muy Util para realizar el ajuste preciso de una
sincronizacion de labios.

stop-motion
keyframe
(fotograma clave
de Stop-motion)

Fotograma clave sin interpolacion generada por ordenador.

storyboard

Plan visual de todas las escenas y planos de una animacion. El storyboard indica lo que
sucedera, cuando lo hara y cémo se distribuyen los objetos en una escena.

straight-ahead
animation
(animacién
directa)

Técnica en la cual se dibuja por orden una secuencia completa desde la primera posicién
hasta la ultima. Esta metodologia requiere muy poca planificacion. El lugar en el que el
personaje termina y como llega hasta alli pueden ser una sorpresa tanto para el publico
como para el animador. Este enfoque es espontaneo y creativo, pero puede generar
resultados imprecisos.

strokes (lineas
vectoriales
transparentes)

Lineas vectoriales invisibles que forman las zonas de dibujo. Se pueden ajustar mediante
controladores de curvas Bézier.

symbol (simbolo)

Un simbolo combina animacién, ilustracion o capas en un unico objeto que puede controlar
en una capa. También puede crear simbolos de cada parte del cuerpo en marionetas Cut-
out.

En un simbolo puede colocar lo que desee. Puede utilizar simbolos para animar una
marioneta o crear animaciones reutilizables, como intermitentes.

tablet/pen

Dispositivo utilizado junto con un ratén, o en lugar del mismo, para mover el puntero (en
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ocasiones denominado cursor) por la pantalla del ordenador.

template Recurso almacenado en la libreria que se puede reutilizar en cualquier proyecto. Una
(plantilla) plantilla puede ser un dibujo, una serie de fotogramas clave, un archivo de sonido, un panel,
un personaje Cut-out, un efecto, una trayectoria, una animacion o cualquier otra cosa que
se utilice en la animacion.
thumbnail Imagen muy pequenia utilizada como una referencia o indicador.

(imagen miniatura)

timecode (cédigo
de tiempo)

Informacion de tiempo impresa en un clip de pelicula para indicar la escena, hora, minuto y
segundo que se muestran actualmente en pantalla.

timeline (linea de
tiempo)

Representacion horizontal de los elementos, el tiempo y los fotogramas clave de una
escena.

trace and paint
(trazar y pintar)

Una vez que los bocetos de las animaciones se han limpiado y se ha realizado una prueba
de linea o de lapiz final, cada dibujo se traza y se pinta para la animacion final. En el mundo
digital actual, esto se puede realizar de maneras distintas a los métodos de celuloide o
acetato tradicionales.

track breakdown
(desglose de pista

Desglose de una pista de pelicula animada en sonidos individuales para generar la posicion
fotograma a fotograma precisa de cada sonido.

de audio)

traditional Tipo de proceso de animaciéon mediante el cual todas las secuencias de animacion se
animation dibujan a mano en papel antes de digitalizarlos o tintarlos en celdas.
(animacién
tradicional)

trajectory Ruta o trayectoria generada por ordenador que pueden seguir los elementos. La trayectoria
(trayectoria) se puede controlar mediante puntos de control, fotogramas clave y velocidad.

transition Efecto colocado entre dos escenas cuando se pasa de una a otra. Efectos de transicion

(transicién)

comunes son el fundido encadenado y el borrado.

underlay (capa
de fondo)

En animacion, una capa de fondo es una parte especifica de la decoracion colocada detras
de la animacién principal.

vector

Una imagen basada en vectores esta compuesta por puntos y curvas Bézier. El ordenador
lee los puntos y traza los segmentos, vinculandolos para reproducir la forma de imagen.
Una imagen vectorial no contiene tamano fijo ni resolucion. El grafico se puede ampliary
distorsionar segun se desee y el sistema volvera a calcular los segmentos y reconstruira
las formas. Las imagenes vectoriales se trasladan y se muestran en pixeles una vez que el
calculo se ha realizado.

velocity
(velocidad)

En animacion, la velocidad es la aceleracion o la deceleracion de un movimiento. Se puede
alcanzar mediante una curva de funcién o una serie de dibujos animados. Otros términos
comunes para aceleracion-gradual y desaceleracion-gradual son aceleraciony
desaceleracion.

walk cycle (ciclo
de andar)

Serie de dibujos "en el lugar" que describen cédmo camina un personaje. La ilusion de
movimiento se crea utilizando paneos de fondo. Para evitar realizar innumerables dibujos,
los animadores suelen realizar un ciclo de andar para un personaje.

zone (zona)

Area que se puede pintar con color.
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indice

a la derecha
rotacion 15
alaizquierda
rotacion 15
aceleracion 111
aceleracion-gradual 105
adicion
vistas 11
alimentador de papel automatico 103
animacion 103
camara 79, 81-82
capas 79
efectos a lo largo del tiempo 95
objetos 79
animacion Cut-out 105

animacion de un personaje Cut-
out 63

creacion 63
creacion de personajes 43
piezas de dibujo 43
seleccién de capas 65
animacion sin papel 109
animacion tradicional 23,112
pintado 19-20
trazado de animacion 28
animatica 103
anime 103
arco 103
atajos de teclado 107
baja resolucion 108
bocetos 110
camara
animacion 79, 81-82

cémo agregar y emparentar con un
peg 81

posicion, configuracion de

escena 71
canal alfa 103
capa de fondo 112
capas 108
animacion 79
cémo emparentar 47

paneo con herramienta Transform
(Transformar) 74

rotacion con herramienta Transform

(Transformar) 74
seleccién de capa padre o hija 65

sesgo con herramienta Transform
(Transformar) 76

carta de campo 106
carta de color 104
carta de exposicion 106
carta de rodaje 105
celda 104
celuloide
consulte celda. 104
ciclo 105
ciclo de andar 112
cierre
huecos 21
cinematica de avance 106
circulo cromatico 105
cleanup 104
trazado 28
CMYK 104
cédigo de tiempo 112
cdmo emparentar
capas 47
composicién 105
configuracién de escena 71
cambio de posicién de pivote 76

cambio de posicién de pivote
permanente 76

colocacién de camara 71

colocacién de objetos 74
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escalado de capa con herramienta
Transform (Transformar) 75

paneo de capa con herramienta
Transform (Transformar) 74

rotacion de capa con herramienta
Transform (Transformar) 74

sesgo de capa con herramienta
Transform (Transformar) 76

corte 105
Corte de salto 107
creacion

escenas de la escena de
bienvenida 9

creacion de personajes
cémo emparentar capas 47
descomposicion 43
piezas de dibujo 43
recorte 43
cuadro de texto 104
curva Bézier 103
deformacion

ajuste de cadena de
deformacion 55

cadena, configuracién de hueso y
articulacion 55

deformacion de huesos 51
rig basico 52

rig de hueso 53

rigging 52

visualizacion de controles de
deformacién 58

deformador de huesos 51

animacion del deformador de
huesos y articulaciones 59

rig basico 52

rig de hueso 53

rigging 52
depuracion 111
desaceleracion 111

desaceleracion-gradual 105
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descomposicién 104
como emparentar capas 47
personaje 43
piezas de dibujo 43
desglose de pista de audio 112
desplazamiento pequefio 109
deteccion de sincronizacion de labios
manual 108

deteccion manual de sincronizacion de
labios 108

dialogo 105
dibujo 17
piezas, creacién de personajes 43
dibujos
morphing 31
pintado 20
directa 111
disefio del personaje 104
DPI 105
efectos
acerca de 93
adicion 93
animacion a lo largo del tiempo 95
eje 103
escalado

capa con herramienta Transform
(Transformar) 75

escenas 111

creacion desde la escena de
bienvenida 9

exportacion

pelicula 101

QuickTime 101
exposicién 106
film-1.33 106
film-1.66 106
flipping 106
fondo 103

fonema 110
fonemas
carta 109
fotograma 107
fotograma clave 108
fotograma clave de movimiento 109
fotograma clave de Stop-motion 111
fotogramas por segundo 107
funciones 107
fundido de entrada 106
fundido de salida 106
fundido encadenado 105
gama 107
guion 111
HDTV 107

herramienta Close Gap (Cerrar hueco)
22

herramienta Transform (Transformar)
capa de escalado 75
capa de paneo 74
capa de rotacién 74
capa de sesgo 76
herramientas
Cerrar hueco 22
Hold 107
HSV 107
huecos
cierre 21
imagenes de mapa de bits 104
conversion en dibujo vectorial 41

importacion como dibujo de mapa
de bits 39

importacién en formato original 35
Imdgenes en miniatura 112
importacion

archivo de sonido 89

conversion en dibujo vectorial 41
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imagen de mapa de bits como dibujo
de mapa de bits 39

imagen de mapa de bits en formato
original 35

plantillas 70
importacién de sonido 89
ink and paint 107
intercalado 107
interfaz 11

navegacion 13
interpolacién 107
lapiz 112
layout 108
layouty pose 108
libreria 108

creacion de plantillas 69
limpieza 27
linea de accion 108,110
linea de tiempo 112
lineas vectoriales transparentes 111
mesa de luz 108
mesa de rotacion 110
model sheet Véase: character design
modelo 109
modelo de color 104, 109
morphing

dibujos 31

eliminacion 33
multiplano 109

creacion 85
navegacion

acercar 14

acercar o alejar 14

alejar 14

centrado de la pantalla en raton 15

interfaz 13

paneo 14

pantalla completa 14
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restablecimiento de paneo 14
restablecimiento de rotacion 14
restablecimiento de vistas 14
restablecimiento de zoom 14
rotacion a la derecha 15
rotacion a la izquierda 15
volver a centrar vista 14

NTSC 109

objetos
animacion 79
posicion 74

PAL 109

paleta maestra 108-109

paletas 109
estilo 109

panel 109

paneo 14,109

capa con herramienta Transform
(Transformar) 74

restablecimiento 14
pantalla completa 14
papel cebolla 109
peg maestro 49
adicion 49
pegs 110
adiciéon de maestra 49
maestra 49
pintado 19
dibujos 20
pivote 110
cambio de posicién 76
cambio de posicién permanente 76
pixel 110
pixelation Véase: bitmap image
plano 111

plano de situacion 105

plantillas 112
creacion 69
importacion 70

pose a pose 110

pose clave 107

posicion de paso 110

proceso
pintar 19

proporcion 103

QuickTime
exportacion 101

renderizado 110

resolucion 110

restablecimiento
panear 14
rotacion 14
vistas 14
zoom 14

RGB 110

rig de hueso
creacion 53

rigging 52,110
adicion de peg maestro 49

cadena, configuracién de hueso y
articulacion 55

como emparentar capas 47
rig de deformacion basico 52
rig de hueso 53

visualizacion de controles de
deformacion 58

rotaciéon

capa con herramienta Transform
(Transformar) 74

restablecimiento de rotaciéon 14

rotacion a la derecha 15

rotacion a la izquierda 15
rotoscopia 110

secuencias 111

116

seguimiento 106
sesgo

capa con herramienta Transform
(Transformar) 76

sincronizacion de labios 90, 108
adicion 89
deteccion automatica 91, 103
slugging 111
sonido
depuracion 111
importacion 89
importacién de archivo de sonido 89
sincronizacion de labios 89-90
storyboard 111
superposicion 109
tableta 112
tradigital 109
transicion 112
trayectoria 112
trazado 28
trazary pintar 112
usar carta de rodaje 105
vector 112
velocidad 105,112

configuracién en varios
parametros 66

vibracion de camara 104
vista de libreria
importacién de plantillas 70

Vista de propiedades de la
herramienta 13

vista lateral

apertura 81

colocacién de elementos 86
Vista superior

apertura 81

colocacién de elementos 86
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vistas
adicion 11
Propiedades de herramienta 13
restablecimiento 14
volver a centrar 14
volver a centrar
vista 14
zona 112
zona segura 111
zoom
acercar o alejar 14
alejar 14
en 14

restablecimiento de zoom 14
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